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ABSTRACT 

This project examines the design and implementation of a development of JJ

Market homepage, the Online Shopping Web site for Thai products. 

As our economy in Thailand is very bad now, many people are unemployed. 

Setting a small business is the way to survive. Internet is very popular right now, more 

and more people are using the Internet. Therefore, it is a good chance to set up a small 

business on the Internet, because setting up business on the Internet does not require 

much investment. 

This project will inform you and give you example of setting a small shopping 

Web site on the Internet. It will start from creating the Web site that uses NetObjects 

Fusion as a Web authoring program. Then this project will help you find the ISP to 

upload your Web site. This project also includes the way to promote Web site. And the 

last chapter will discuss about how you can charge your customers online with their 

credit cards and earn money from your Web business. 

This project could be a good example for everyone who wants to do a business 

on the Internet. It will guide you as to what you have to do and the steps to begin. The 

project was implemented and uploaded to the Internet at http://www.jj-market.com. 
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I. INTRODUCTION 

It was not too many years ago that I began hearing about this new thing called the 

Internet. I had had accounts at AU NET as a student account. Then people started 

talking about this new sub-thing called the World Wide Web. It was extremely cool, 

even at that time I could see only text and still graphics. 

Right now technology has changed very fast, World Wide Web has not been the 

same. You could do animated graphic, short video, sound or programming on Web 

page. And many companies could jump into Internet Business called E-Commerce. This 

is the new way of doing business. You do not have to pay big amounts of money on 

rent, electricity or water supply as real business offices do. And you could do business 

24 hours a day and 7 days a week. Do not think of business, knowing how to write 

homepage could bring you to a new way of presenting yourself, your idea or any thing 

else you would like people to know with unlimited boundaries because everyone in the 

world could explore your homepage via the Internet. 

Now I think you might want to have your own homepage. But some of you may 

think that creating homepage is very hard. I could tell you that if you are familiar with 

word processor program, you could do it easily. By reading this project, you could 

create your own homepage even your own web site. 

Let's face it. If you got this far, you obviously did not buy your computer 

yesterday. I have to believe that you have had at least an experience at browsing the 

Web. And I also cannot help but assume that you know how to do a few basic tasks in 

Windows, like click the Start button or open a file from within an application. If you 

meet these minimum requirements, you are ready for some Web action. 

I choose to use NetObjects Fusion as my Web authoring program because this 

program is very easy to use but powerful enough to make a great Web site. You may 
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download this program for evaluation use at http://www.netobjects.com. NetObjects is 

top at creating great software. And the company's also tops at talcing care of their 

customers. If you finish reading this project and still want to know more, I suggest you 

visit the NetObjects Web site. This Web site has one of the best customer support 

centers I have seen, and it is constantly updated. 

I think you might want to create your web right now therefore let us begin. 
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II. LITERATURE REVIEW 

2.1. Project Overview 

JI-Market: Homepage Development is a project about creating an online Web 

shopping for small business. The project will describe all steps from beginning of 

authoring Web site, finding Web server to store your Web site on the Internet, 

advertising your Web site and taking an order from your customers. Chapters 3-4 will 

describe how to create the Web site by using the program called NetObjects Fusion that 

I think is easy to use and powerful enough to create a good Web site. Chapter 5 will 

describe the step of finding Web server and how to upload all your Web pages to the 

Internet. There are many Web servers in the Internet. They are different in services, 

prices and options provided. You have to know the size of your Web site and what 

option you need, so you will find the right server at the right price. Chapter 6 will 

describe the steps of promoting your Web site, this includes the way of using banner 

link, printed material or even bulk e-mail. This chapter will tell you what to use and 

most benefit to your Web site. The last chapter, chapter 7 will tell you on how to 

register with CCN ow and how to use this system to create online shopping in your Web 

site. The chapter will describe how you can earn your money from selling your product 

on the Internet. 

2.2. Project Objectives 

The objective of this project is to provide knowledge of creating Web site with an 

online shopping. This project will be a good example for small business or anyone who 

just wants to start their own business on the Internet. As you know, the Internet is very 

popular fight now and business on the Internet does not require big amount of money 

for investment. 
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2.3. Scope of the Project 

This project will cover the knowledge and technique of authoring Web site, 

finding Web server, promoting Web site and setting online shopping Web site with 

CCNow system. The whole Web site will be really uploaded to the Web server on the 

Internet, therefore it will really operate and ready to taking any order. 

The project does not cover too many details on writing html or JAVA 

programming. The project does not give you more detail on how to create Web 

graphics. 
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ID. BASIC STEPS OF CREATING WEB SITE 
WITH NETOBJECTS FUSION 

3.1. Getting on Your First Web Site 

There are steps in setting up web site that you must follow, whether you are about 

to create business web site for your own business or just present yourself. 

You have to decide on the topic of your home, whether it is for your business or 

yourself. Then you have to gather all information as much as you can. 

Classify your information you have got into categories, for example if you want to 

set up web site for your home business. Your categories might consist of 

(1) The introduction: In this section, you might describe your business history. 

(2) Products and Services: In this section, you have to list all the products or 

services you have carried. 

(3) Customer Service: In this section, you have to provide information like how to 

order, shipment ways, rate of shipment, delivery time, return policy and etc. 

(4) Contact: In this section, you have to provide your customer the way to contact 

you. This may be your snail address, telephone number or your email. There 

might be more section depending on your information or type of business. 

Begin to create your web site. In this step you have to choose which web 

authoring software you would like to use, not only web authoring software, you may 

have to use graphic software to create graphic for your web site. Then the big step is to 

create your own web site, using your existing software. But do not worry too much, 

most new web authoring software right now is easy to use. You do not have to know 

much in computer programming, just have experience with Microsoft Office, such as 

MS Word. 

Find you web server to upload your web pages to. In this step you have to find 

which Internet server you want to upload your web pages. It depends on your budget, 
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and kind of your web site. The things you may be concerned are the rate of renting the 

web server, the transfer rate of the web server, the domain name service, and etc. 

Advertise your web page, make people know your web site. You have to submit 

your web address to the search engine. Receive comments and improves your web site 

according to the comments. 

3.2. Getting to Know NetObjects Fusion 3.0 

One thing that impressed me about Fusion 3.0 is that it demonstrates NetObjects' 

responsiveness to customers. I believe they have addressed every concern I've heard 

about the product, from improved code to control over the entire process. 

For instance, Fusion stores sites in a single database file, as opposed to keeping all files 

separate. This means that integration between the different parts of Fusion (the site 

editor, styles, and page editor, for instance) can be much tighter than, say, in Microsoft 

FrontPage, where they are all separate programs (dependent on running a specially

configured server, no less). The disadvantage with this design is that if the program 

crashes, you could potentially lose a great deal of work. 

So Fusion 3.0 now gives you the option to save the site automatically, and keep a 

number of backups (you choose the number). The improved site import means that even 

if your primo Fusion database is lost, you could theoretically re-import the HTML 

pages and assets and be back up to speed. But extra backups are always nice too! 

The quality and quantity of Fusion-generated code is another concern, and Fusion 3.0 

now has an HTML button on every single object: just click it and it will show you 

(more or less) what is being generated. As I mentioned in Part 1, you can still use 

Fusion to add its "Everywhere HTML" and Dynamic Action features to current sites, 

without recoding or worry that Fusion will mess up your code (try that with 

FrontPage!). 
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NetObjects styles have always been of high quality, and there are 55 new ones in 

Fusion 3.0, with a total of 150 for you to goggle over (decisions, decisions!). And while 

I have the attention of the designers in the audience, I have two words for you: pixel 

rulers. 

Publishing to servers has also been vastly improved, with support for multiple 

Web servers, publishing of changed assets only, and control over the final directory 

structure (i.e. you can put all the files in one directory, separate them by asset type 

(sounds, images, HTML, etc.) or mimic the site design structure). I wasn't able to test 

these features in the beta version, though. 

Especially if you're approaching professional Web design/development from the 

design side, where you really do care where all your objects fall on the page, and where 

you don't have time to continually write JavaScript kludge code to detect different 

browsers, but you want full control over animation and dynamic elements and your 

code, as well as managing your site's assets without having to worry about proprietary 

server extensions ... there may be nothing else for you but NetObjects Fusion 3.0. 

3.3. The Basics of Site Creation 

With most Web publishing programs, you start your Web site project by sitting 

down with a paper and pencil and mapping out a flow chart of exactly how you want 

your site to be organized. With NetObjects Fusion, however, you can keep all those 

pencils stashed securely in your desk! NetObjects Fusion provides you with all the tools 

you need to do every inch of your design work right on your computer, including that 

preliminary planning. 

Net Objects Fusion comes with all sorts of goodies that make Web-site creation 

easier and your Web site more visually pleasing. Before you jump into all those extras, 
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however, you need to know the basics of creating and modifying a Web site in 

NetObjects Fusion. That is what this chapter delivers! 

3.4. Creating a Web Site 

Chances are you have already created some sort of Web site in NetObjects Fusion, 

but I will walk you through the steps just to make sure that you and I are on the same 

page. 

Turn on your computer and start NetObjects Fusion. If you did a normal 

installation of NetObjects Fusion, you have the option of going through the Start menu 

or simply double-clicking the NetObjects Fusion 3.0 shortcut appears on your Windows 

desktop. If you have created a site previously, NetObjects Fusion opens that site at 

whatever points you left it. If you have never created a Web site, NetObjects Fusion 

brings up the Welcome to NetObjects Fusion dialog box, which asks you to create or 

open a new site. 

Choose File:=>New Site=>Blank Site. You can also use Ctrl+N to create a new 

blank site. NetObjects Fusion displays a New Blank Site dialog box, as shown in Figure 

3.1, and prompts you to type in a file name for your new site. You can use just about 

any name you want; you are allowed to use spaces, punctuation, and so on. 

You also have the opportunity at this point to specify the exact location on your 

hard drive where you want to store the files for your new site. The default location is a 

NetObjects subfolder called User Sites. 

Although you can specify any location you want, I believe the User Sites folder is 

a good choice. 
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Figure 3.1. Give Your Site a Name. 

Type in a name for your new site and click the save button in the lower-right 

corner of the dialog box. NetObjects Fusion displays your new site with its lone home 

page in the Site view. If your new site doesn't appear in Site view, click the Site view 

button at the top of the page to switch over. 

Note that you can only have one site open at a time. Any time you open or create 

a new site while another site is already open, NetObjects Fusion takes a few seconds to 

close and compact (clean up unnecessary stuff) the open site. Exactly how long this 

takes depends on the speed of your computer, so just be patient. 

Take special notice of the Properties palette that most likely appeared somewhere 

on the right side of the screen. If you do not see the Properties palette, choose 

Window=>Properties Palette, or simply press Ctrl+U. This little palette is destined to 

become one of your closest allies as you create Web sites in NetObjects Fusion. 

Depending on exactly what view you are in and what you are doing, you can access 

almost all of your options from the Properties palette. 
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3.5. Adding Pages - Moving and Deleting 

Every Web site starts with a home page, the first page that people encounter when 

they visit your Web site. The rest of your site is arranged in a hierarchy. Hierarchy is a 

word that Web nerds and computer geeks use to impress each other (and bore everyone 

else). It basically means that something is grouped in ranks, with some things above 

others and some things below others. If you are ever bothered to look at your 

company's org chart, you know what I'm talking about. In the case of your Web site, 

you can have one or more pages directly below your home page in this hierarchy, one or 

more pages below each of those pages, and so on. To Add pages to your site. 

In this set of steps, I assume that you have already started the NetObjects Fusion 

program and created a new blank site, as I explained in the preceding section "Creating 

a Web Site." Adding more pages to your site is easy. 

Click the New button in the tool bar, or what NetObjects Fusion calls the control 

bar, at the top of the screen. See Figure 3.2. A new untitled page appears directly below 

your home page. You can also press the Insert key or choose Edit:::::}New Page to create 

a new page. Notice the blue border around the home page. The blue border indicates the 

page that is currently selected. Any time you create a new page, NetObjects Fusion 

places that page one level down in the hierarchy from the currently selected page. 

Figure 3.2. New Button. 

10 



To create another page at the same level as the previous new page, click the New 

Page button again. A third page appears next to the second one. 

To create another new page below one of the existing new pages, click that page 

to select it; then click the New Page button. This time around, the new page appears 

below the one you selected. You can now add all the pages you want using this same 

basic technique. 

Take a look at the small arrow pointing out of the bottom of the home page 

(assuming you have created other pages below it). This arrow, as shown in Figure 3-3, 

appears below any page that has pages below it. If you click that arrow, all the pages 

below that page are hidden. This can help save a little room when you are working in 

Site view. To see them again, just click the little circle with the plus sign in it. 

Figure 33. You Can Hide Extra Pages. 

Suppose you create a new page and then decide you created it in the wrong place. 

Moving a page around in the Site view is as easy as dragging and dropping. Just follow 

these steps. Click and hold the mouse point on the page that you want to move. 

Drag the mouse pointer over another page. An outline of the icon for the page you 

are moving moves along with the mouse pointer as you drag. As you drag the mouse 

point over the icon for another page, a little red arrow appears along one of the borders 

of the other page's icon. The border on which the red arrow appears depends on where 
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you drag the mouse pointer. For example, if you drag the mouse pointer along the right 

side, the red arrow appears on the right border. The position of the red arrow tells you 

where, in relation to the other page, NetObjects Fusion will place the page you are 

moving after you release the mouse button. Figure 3.4 shows one example with the red 

arrow on the right side of the other page. Releasing the mouse button moves the page to 

its new position, as indicated by the little, red arrow. 

Release the mouse button to complete the move. You can use this same basic 

technique to move pages anywhere you want within your site's hierarchy. To delete a 

page, follow these steps. 

Click the page you want to delete. As you probably remember, when you are in 

the Site view, the currently seleted page is indicated by a blue border. 

Press the Delete key on your keyboard, or choose Edit~Delete Page. Once you 

delete a page, there is no turning back, so make sure this is what you really want to do. 

NetObjects Fusion displays a warning message like the one shown in Figure 3.5. 
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Figure 3.4. Releasing the Mouse Button Now Places 
the Page to the Right of the Jobs Page. 

Figure 3.5. Once You Delete a Page, It Is Deleted for Good. 

I 
I 

To complete the deletion, click the Yes button in the warning box. The next page 

up in the hierarchy becomes the selected page. 
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3.6. Changing Web Page Name 

Maybe you have already noticed that each time you create a new page, it is simply 

named Untitled. As you are planning the structure of your Web site, having a bunch of 

pages named Untitled is sure to confuse the matter. 

Imagine if you stopped by to pick up a pizza at your favorite pizza parlor and they had 

five different pizzas named The Special. How could you possibly know which one you 

were ordering? 

To make your life as a Web author as easy as possible, you want to give each page 

on your site a unique name. That way, you keep any name confusion to an absolute 

minimum. To change a page's name, make sure you are in Site view and follow these 

brief steps. 

Move your mouse pointer over the name of the page you want to change. As you 

do this, a light box appears around the name and the current name change color. 

Click the mouse pointer on the current name. The current name becomes 

highlighted. 

Type in the desired name for the page. The old name is automatically replaced 

with the new name. Press the Enter key and you are done. 

NetObjects Fusion automatically fills in the name you entered into the Properties 

palette. Make sure that the page you just named is still selected (if not, click it), and take 

a look over at the Properties palette on the right side of your screen. (If you cannot see 

the Properties palette, press Ctrl+U.) NetObjects Fusion displays the Page tab and, 

among other things, you can see the new name you gave the page in the Name text box. 

For Figure 3.6, I changed the page name to "health." 
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Figure 3.6. The Properties Palette Shows the Page Name. 

Give each page a name that is easy for you to identify and work with. NetObjects 

Fusion fills in a page name for you at other times, too. Because the name that is easy for 

you to work with may not necessarily be the name you want other people to see, 

however, NetObjects Fusion allows you to specify other names for it to use. That's 

where the Customer Nam es button comes in. 

The Customer Names button enables you to specify different page names for 

NetObjects Fusion to use in different situations. You can find the Custom Names button 

below the page name in the Properties palette. To see what you can do with the Custom 

Names button, look again at any current home page, as shown in Figure 3.7. 
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Figure 3.7. Here Is the JI-Market Virtual Home Again. 

Notice that NetObjects Fusion displays different variations of the page name in 

three different places. The title bar at the top of the browser windows shows the actual 

HTML name of the page, JI-Market: Thailand best product online shopping. In the 

banner at the top of the page, the page is called JI-Market.Com. Then over in the 

NavBar, the icon for this page is simply called Home. 

Here is how to change the custom names for any given page. Click the desired 

page to select it. The selected page is the one with the blue border. Click the Custom 

Names button in the Properties pallette. A Custom Names dialog box appears on your 

screen, as shown in Figure 3.8. 
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Figure 3.8. This Is Where You Specify Custom Names. 

Type in the page name in the Page Title field as you want it to appear across the 

top of the browser window when people visit this page; then press Tab. The next field in 

the dialog box becomes highlighted. 

Type in the page name in the Navigation Button field as you want it to appear on 

buttons that NetObjects Fusion creates for you; then press Tab. Because buttons have 

limited space for text, you should keep the name brief. For example, on my site, the 

button name for the page that links to my writing samples is simply Samples. 

Type in the page name in the Banner field as you want it to appear in the banner 

across the top of the page. If you want your banner to have more than one line of text, 

you can press the Enter key to move down to a new line. If you are creating a page for 

some specialized application that requires change to have some extension other than the 

standard .html, you can change that here on a page-by-page basis. However, that is 

outside the scope of this book. 

When you are done specifying the various names, click the OK button to close 

this dialog box. 
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3.7. Fine Tuning Your Site 

NetObjects Fusion offers several other options to help you make sure your site 

turns out just the way you want. You control some options by using the Properties 

palette and some by using other buttons. 

When you are in the NetObjects Fusion Site view, the Properties palette usually 

displays three different tabs: Page, Site, and View. The only exception is that when you 

display your site in Outline View, there is no View tab. For more on this, check out the 

following section, "Structure view versus Outline view," in this chapter. 

The Page tab, in addition to Custom Names, these are the things you can control 

from the Page tab, which is shown in Figure 3.9. 

Figure 3.9. The Page Tab Is Always Available in Site View. 

The Color button allows you to change the color of the icon used to represent any 

given page in Site view. When you click this button, NetObjects Fusion displays a 

typical Windows-style color-selection dialog box. You may find this feature handy if, 
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for example, you want all pages that relete to a particular topic to be readily visible 

when you are in Site view. 

Status offers two radio buttons, Done and Not Done. The default is Not Done. 

When you select the Done button, a small check mark appears in the upper-right corner 

of the selected page's icon, as shown in Figure 3.10. The check mark gives you visual 

notice that this particular page no longer requires your attention. 

Figure 3.10. This Page Is Ready to Go. 

Publish and Don't Publish offer you the choice of whether to publish your page on 

the Web. Why would you want to not publish a page? Suppose you are working on a 

big site and you need to get part of it online before the whole project is complete. You 

can choose to not publish the pages that are only partially complete, and NetObjects 

Fusion temporarily leaves them out. 

The Comments text box is simply a place where you can type in any notes or 

reminders that may help you out later. 

3.8. The Site Tab 

As you can see in Figure 3 .11, the Site tab tells you the name of the site you are 

working on, the date and time it was created, the date and time it was last modiffied, 

and the total number of pages in the site. It also provides a field where you can type in 

your name as author of the site. 
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Figure 3.11. The Site Tab Provides a Summary of Your Site. 

After you type in your name, NetObjects Fusion generates HTML code for your 

site, including meta tags on each page. A meta tag is a segment of HTML code that is 

included on a Web page but is not visible in any way when the page is viewed through a 

Web browser like Netscape Navigator or Microsoft Internet Explore. 

Meta tags can, cause an action to occur. For example, if you were coding all your 

HTML manually (versus using a program like NetObjects Fusion), you could add a 

meta tag that automatically advances the user to a different page after a specified period 

of time. 

Provide information to people or programs that examine the html code that makes 

up your pages. For example, when NetObjects Fusion generates the HTML code for 

your site, it automatically adds a meta tag to each page that tells the name of the author 

of the Web page and that the site was created using NetObjects Fusion. 
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3.10. Other Tools and Buttons that Put You in Control 

The Site view also provides a couple of other options to help you control how 

your site appears on the screen. 

The Standard Tools palette, when you are in Site view, the Standard Tools palette 

that appears along the left side of the screen holds only two tools, a pointer and a 

magnifying glass. Most of the time, you are going to be using the pointer tool. However, 

if you ever want to zoom in to see something better, you can click the magnifying glass 

and then click the portion of the site you want to magnify. 

You can create a little more working room by hiding the Standard Tools palette 

completely. To do so choose View=>Toolbars=>Standard Tools. You can later use the 

same procedure to bring the palette back. 

Structure view versus Outline view, when you are in Site view, just below the 

control bar, you find two tabs: Structure and Outline. Structure view, the default, shows 

your site as a flow chart. When you click the Outline tab, N etObjects Fusion switches 

over to a view that looks like an outline, as shown in Figure 3.13. 

You cannot find any new information here but, depending on your personal 

preference, you may find the Outline view easier to work with. One interesting column 

that you see on the right side of the screen is called Child Name In Web authoring lingo, 

any page that site below another page in the hierarchy is called a child. Likewise, the 

page directly above any given page in the hierarchy is called its parent. 

3.11. Take the Easy Way Out with Templates and Styles 

In a way, building your Web site in NetObjects Fusion is like building a 

bookshelf. If you want to build a bookshelf, you can go down to the local lumber store, 

buy a pile of wood, bring it back home, spend hours cutting the wood, get ticked when 

you screw up, start over ... (you may actually be handier with wood than I am). 
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Figure 3.13. Here Is the Site View with Your Perspective Already Changed to an 
Outline View. 

The option that seems to work better for a novice woodworker like me is to make 

a trip to the department store, buy a kit that has everything cut to the right sizes, bring it 

home, and promptly assemble it. 

When you use NetObjects Fusion to create your Web site, you can certainly start 

from scratch, but you may not want to go to all the trouble. Before you get too far down 

the build-it-from-scratch road, you should take a look at two of NetObjects Fusion is 

most useful features: AutoTemplates and Styles. 

An AutoTemplate is a predesigned, fill-in-the-blank site that you can use as a 

model for your own site and modify wherever you see fit. NetObjects Fusion comes 

with three AutoTemplates (or just templates for short): Business Presentation, Company 
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Internet, and Department Intranet. A SiteStyle, or simply Style, is a collection of 

coordinated elements that NetObjects Fusion also employs a Style. NetObjects Fusion 

comes with more than 50 Styles to choose from. Plus, you can also create your own 

Styles. 

3.12. Using AutoTemplates 

To create a Web site using an AutoTemplate, just follow these steps: 

Choose File=>New Site=>From Template. NetObjects Fusion displays a Selete a 

Template File dialog box, as Figure 3.14 shows. In addition to full site templates, the 

program also includes templates for various types of forms, some specialized Web 

pages, and data publishing. 

r··································································································································.··················.·.··············· 

Figure 3.14. NetObjects Fusion Templates Are Divided into Three Categories. 

Double-click the AutoSites folder. The dialog box displays five folders: Blank 

Site: The template that NetObjects Fusion uses when you choose File=>New Site=> 

Blank Site or press Ctrl+Shift+N. This is the default site template. 
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Business Presentation: This template enables you to put a presentation on the 

Internet similar to a Microsoft PowerPoint presentation, complete with animated effects. 

Corporate Internet: This template gives you a big head start if you are trying to 

put your corporation on the Internet for the first time. The template also contains 

methods of publishing database information on the Web such as open positions at your 

company. 

Department intranet: This template is the structure for sharing information within 

the same department of a company. 

Import: NetObjects Fusion uses this template when you choose File=>New Site=> 

From Local Import. Double-click the folder for the template you want to use. 

The dialog box displays the Assets folder for that template, as well as the template 

file. Click the template file and then the Open button in the lower right corner of the 

dialog box. 

NetObjects Fusion creates a new site based on the template you seleted. This may 

take a minute or two, depending on the speed of your computer. Once you see the site 

displayed in Site view, you are ready to get to work customizing the template to your 

specific needs. 

3.13. Contemplating Templates 

Previous version of NteObjects Fusion was shipped with about a dozen different 

templates, but none of them were really anything special. NetObjects Fusion 3.0 ships 

with only three templates, but each represents a very common use of a Web site (and 

each showcases a different aspect of the program). You can use one template as a model 

for a business presentation, one for your company's Web site, and one for a department 

site on a company intranet. Use a template as a starting point, and then customize it to 

meet your specific needs. 
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Facts and Figures, to be perfectly honest, the Business Presentation template does 

not offer that much in the "fill in the blank" department as you might hope for. You can 

customize some of the pages, but others use graphics (for example, a pie chart) that are 

specific to the fictional company represented in this template. What this template does 

do, however, is provide a fine example of what is possible with a NetObjects Fusion 

feature called Action. A little background information is in order here. 

Your Corporate Presence, if you are building your company's Web site from 

scratch, one of the big questions is what information to put in and what information to 

leave out. You probably will not be faulted for putting in too much, but leave out 

something the CEO thinks is critical and you could find yourself in hot water. The 

Corporate Internet template may not include everything you need for your Web site, but 

it is a great start. 

As you can see the Site view displayed in Figure 3.15, the Corporate Internet 

template provides the basic framework for a corporate Web site. Just as with any 

template, you can add, delete, and modify as you see fit. 

NetObjects Fusion lets you publish data that is either stored within your 

NetObjects Fusion site or housed in some other database format. Either way you go, 

NetObjects Fusion creates a DataList on a parent page to display a list of the various 

records that make up your data. Then the program creates a stacked page for each 

record. To view one of those stacked pages in your Web browser, click the appropriate 

entry in the DataList. 
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Figure 3.15. Use the Corporate Internet template and You Are Already Halfway to 
Getting Your Company Online. 

An Online Compartment for Your Department, more and more companies today 

are creating what are called intranets. An intranet is simply a Web site (or series of Web 

sites) set up on a company's internal computer network. Unlike sites that you publish on 

the World Wide Web, an intranet site is available only to the employees on the company 

network. 

Although many of the design considerations are the same, the type of information 

you want to share with fellow employees may be vastly different from the information 

you want to share with the rest of the world. Because the whole purpose of an intranet is 

to provide easy access to useful employee information, you want to publish information 

that other employees are likely to need to perform their duties more efficiently. If you 
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are wondering what to include on your intranet site, the Department Intranet template is 

an excellent place to begin. 

Feature-wise, the Department Intranet template does not offer much different from 

the Corporate Internet template. Figure 3.16 shows an example of this template in Site 

view . 

•• :·:.."~:: ... :.·· .. 

Figure 3.16. Here's Just about Everything You Need to Get Your Department Seen in 
Cyberspace. 

If you do happen to be creating a site for your corporate intranet, you should keep 

two things in mind. First of all, chances are that the IS powers that be have prescribed a 

particular Web browser to be used by everyone in the company. If that is the case, you 

can design your intranet site with that particular browser in mind. In particular, if your 
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company has standardized on a 4.x browser, you can incorporate 4.x only features, such 

as Actions, into your site without worrying about who has which browser. Second, you 

do not need to worry quite as much about bandwidth on an intranet. When you publish 

on the Internet, you have to give some consideration to people who might access your 

site via a modem connection. On the other hand, everyone on your intranet is tied 

together with high-speed data lines. I am not suggesting that you should load your 

intranet site with scads of multimegabyte multimedia files; such stuff is typically not 

appropriate for a business setting anyway. However, if you really need some high

bandwidth content to make your intranet site complete, slow modem connections are 

not one of the issues you need to address. 

3.14. Do It with Style 

If your graphic arts skills are anything like mine, you welcome any help you can 

get. Lucky for people like you and me that NetObjects Fusion comes with an assortment 

of what are called Style. A style is a collection of related graphics, each of which is 

designed to serve a specific purpose on your Web page. To be precise, each style 

consists of the following graphic elements: 

Background. A Style background can be either a solid color or a picture of some 

sort. 

Banner. The Banner is the large graphic that appears across the top of your Web 

page. It usually contains the name of the page. 

Primary Button. This is the image you use for each of the buttons in your 

NavBars. The Primary Button is actually a set of two buttons, one for regular and one 

for highlighted. The highlighted button indicates the current Web page. 

Secondary Button. This is an alternate button set that you can use at will instead 

of the Primary Button. 
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Line Picture. Instead of using HTML-generated horizontal rules, you can choose 

to replace your rules with this picture. 

DataList Icon. Use this graphic as a bullet character when you publish a DataList. 

Normal Text Color. This option controls the color of normal text on your Web 

page. 

Regular Link Color. This option controls the color of linked text before a user has 

visited the linked-to page. 

Visited Link Color. This option controls the color of linked text after someone has 

visited the linked-to page. 

You can change from one Style to another with just a couple of clicks in 

NetObjects Fusion's Style view. If you do not have NetObjects Fusion running, start the 

program. If you are a little leery of experimenting on your current site, you may want to 

create a new one just to fiddle with. The truth is, it does not much matter, because 

switching back to your original Style only takes a couple of mouse-clicks. 

With a site loaded, click the Style button in the button bar at the top of the screen. 

When you do, NetObjects Fusion takes you to the Style view and displays a list of all 

available Styles, much like Figure 3.17. 

On the left side of your screen, NetObjects Fusion displays the actual list of Style. 

On the right side of the screen, you see the various elements that make up whatever 

Style you click in the list. Let me take a moment to explain the various elements of a 

Style. 

The Banner area shows you the banner graphic, the banner text font, and the color 

of the banner text. 
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Figure 3.17. NetObjects Fusion Provides an Impressive Array of Styles. 

The Primary Navigation Bar area shows you what a NavBar that has this Style 

looks like. The button that looks different from all the others represents the current 

page. 

Every Style offers an alternate NavBar that you can use at will. The Secondary 

Navigation Bar area shows you what a NavBar that has the alternate Style looks like. 

The button that looks different from all the others represents the current page. 

The DateList Icon shows the graphic that appears as a bullet character in 

DataLists. The Text area shows the specified colors for normal text, regular links, and 

visited links. The SiteStyle Line area shows the graphic that you can use in place of 

HTML horizontal rules. 
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NetObjects Fusion comes with more that 50 Style. Some of them are more 

interesting that others. To see what any Style looks like, simply click its name in the list 

on the left. To change the Style for your site, follow these easy steps: 

In the Style view, click the name of the Style you want to use. NetObjects Fusion 

displays that Style on the right side of the screen. 

Click the Set Style button on the right side of the button bar at the top of the 

Screen. NetObjects Fusion displays a message advising you that you have changed the 

Style, as you see in Figure 3.18. If you want, you can select the Don't Show This 

Message Again check box. If you do, NetObjects Fusion makes future Style changes 

without displaying this message, speeding things up a little for you. 

Figure 3.18. NetObjects Fusion Lets You Know When You Have Changed Your Style. 

Switch to Page view to see what your site looks like with its new Style. If you are 

looking at some Style other than the one your site is currently using and then switch to 

another view, NetObjects Fusion displays a message box, asking you if you want to use 

the Style you are looking at. If you choose Yes, a bug in the original shipping version of 

NetObjects Fusion 3.0 causes the program to crash. To avoid this problem entirely, 
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click the Don't Show This Message Again check box and then click No. In the future, 

you will only be able to change Style using the procedures I describe earlier in this 

section. 

Importing Existing Sites into NetObjects Fusion, if you have already created a 

Web site in some other program, you may not want to start all over again with 

NetObjects Fusion. Well, I have got good news and bad news.The good news, you can 

bring your existing Web site into NetObjects Fusion. Now for bad news, the task is a 

little more complicated than it may be in other programs. 

Every other Web authoring program I have looked at - and I have probably 

fiddled with at least a dozen or so - saves its files in plain HTML format. That means, 

for example, that if you wanted to switch from Claris HomePage to Adobe PageMill, 

you could just fire up PageMill and open the files you originally created in HomePage. 

For better or worse, it is not quite that easy when you are migrating to NetObjects 

Fusion, which saves all its files in a proprietary format and does not create an HTML 

code until you actually publish your site. 

You cannot just open an HTML file in N etObjects Fusion and start working on it. 

Instead, you have to go through a process called importing. When you import an 

existing site into NetObjects Fusion, the program examines your old files and then 

makes a fusionized copy of your site. Your new, fusionized copy is what you actually 

work on in NetObjects Fusion. 

If you have an existing Web site and you shelled out a couple of hundred dollars 

for NetObjects Fusion, I have to assume that you want to use NetObjects Fusion in 

modifying that site. In other words, you did not but NetObjects Fusion just to sit on 

your hard drive waiting for the next time you want to modify your site; you want to 
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modify your site right now. NetObjects Fusion lets you import your entire site in one 

big operation, or one page at a time; it is up to you. 

Before you import your existing site into NetObjects Fusion, think about exacly 

how extensively you plan to change your site is. If you are planning a major site 

overhual, you are probably better off starting a new NetObjects Fusion site from 

scratch. You can still use individual elements from your old site if you want to. 

However, if you are happy with the overall look-and-feel of your site and just want to 

add a few fusionistic enhancements, importing is probably the way to go. 

The quickest way to make the move from some lesser Web authoring program to 

NetObjects Fusion is to import your entire existing site into NetObjects Fusion. To 

import an existing Web site into NetObjects Fusion, just follow these steps: 

Start NetObjects Fusion. You can choose Start=>Programs=>NetObjects Fusion=> 

NetObjects Fusion 3.0 or double-click the NetObjects Fusion icon on the desktop. 

Choose File=>New Site=>Imported Site. The Import Local Web Site dialog box 

appears, as shown in Figure 3.19. 

Before you continue, take a look at the options available in the Import Local Web 

Site dialog box: 

The Assign MasterBorder field provides a drop-down list of all the MasterBorders 

you have defined for the site you are importing into. When you complete these steps, a 

separate page is created for each page you reference, with the referenced page 

occupying the Layout area of its respective page. The MasterBorder you select here is 

applied to each of those pages. 
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Figure 3.19. This Dialog Box Enables You to Import from Your Hard Drive. 

The Limit Number of Pages To Box enables you to control the total number of 

pages that NetObjects Fusion imports from a site. Leaving this option unchecked 

imports the entire site. 

The Down to Structural Level Box enables you to control how many levels down 

in the site's hierarchy NetObjects Fusion imports. Again, leaving this option unchecked 

imports the entire Web site. 

It is not absolutely essential that you type the site's domain name inti the Domain 

Name field, but it helps NetObjects Fusion figure out whether links in the site are 

relative links or absolute links. A relative link is a link to another page on the same site. 

In HTML coding, a relative link does not need the http://www.domain.com/ part, which 

is assumed. Only the name of the Web page (such as Index.html) is necessary. An 

absolute link is a link to a page on some other site. 
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Click the Browser button. NetObjects Fusion displays a standard Open dialog 

box. 

Use this dialog box to navigate your hard drive and locate the folder that houses 

your existing site. 

Select the file that represents the site's home page, and then click the Open button. 

In most cases, the home page for a given site is named Index. However, if you used 

some other name for your home page, select that one. After you click the Open button, 

NetObjects Fusion takes you back to the Import Local Web Site dialog box. Make sure 

all the options in this dialog box are set the way you want them. 

Click the OK button. NetObjects Fusion displays a Save Site As dialog box. Type 

a name for your new site in the File Name field. You also have the option to save your 

site in a different location on your hard drive by navigating to that location. However, I 

recommend keeping all your site stored together in the User Sites folder. Click the Save 

button. 

N etObjects Fusion begins the process of importing your site. Depending on the 

size of your site and the speed of your computer, this process could take a few minutes. 

After NetObjects Fusion has finished importing your site, it displays it in Site view. 

If you have already started a site and decide that you want to import that old site 

you created in some other program into your work in progress, just choose File=:::) Import 

Web Site=:::)Local Web Site. Both the procedures and the results are essentially the same 

as those described earlier. 

N etObjects Fusion does not force you to import an entire site when all you really 

want is a single page from the old site. If you decide to build a new site without 

importing the old one, you can still import a single page from your old site whenever 

you need to. 
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You import individual pages when you are in Page view. So when start the 

process, you need to be on the page in your NetObjects Fusion site where you want the 

imported page to appear. When you finish the process, the imported page appears in the 

Layout area of your NetObjects Fusion page. 

The procedures that follow assume that you are already in Page view on the page 

where you want the imported page to appear. To import an individual HTML page, 

follow these steps: 

Select File=::}lmport HTML Page. NetObjects Fusion displays a standard Open 

dialog box. 

Navigate through your system to locate the desired HTML file. Click once on the 

desired HTML file and then click Open. That is all there is to it. NetObjects Fusion 

imports the page you specified. The background of the entire page changes to whatever 

the background was in the imported page, and the page name change to whatever page 

name was used in the imported page. 
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IV. ADVANCED STEPS OF CREATING WEB SITE 
WITH NETOBJECTS FUSION 

Imagine that you are opening a fine restaurant. Presentation is just as important at 

a Web site as it is at a restaurant. Even if you make the absolute most of all NetObjects 

Fusion's site-management tools, your visitors would not notice that if you create ugly 

pages. If your presentation is poor, folks would not return to your site. You do not have 

to be a professional graphic artist to create a nice-looking Web page. All you need is a 

little common sense - and great program like NetObjects Fusion to help you along the 

way. 

Before you can start adding all that good stuff - text, graphics, multimedia, and so 

forth - you need to know how to get around in the NetObjects Fusion Page view and 

how to control some of the basic elements of your page layout. That is what it is all 

about. If you are in Site view right now (or any view other than Page view), just click 

on the Page button in the control bar. That pops you right into Page view. At frrst glance 

- and possibly even at second glance -Page view may seem a little overwhelming. Do 

not worry, though it is not as bad as it looks. 

4.1. Getting the Hang of Floating Palettes 

When you are working on your Web site, the floating palettes you encounter are 

simply little moveable windows that display information about and present options for 

whatever you are working on. 

NetObjects Fusion offers two floating palettes: the Object Tree and the Properties 

palette. To display the Object Tree, choose View~Palettes~Object Tree. To display 

the Properties palette (or hide it if it is already visible), choose View~Palettes~ 

Properties Palette. I will describe the use of the Object Tree and the Properties palette in 

the following sections. 
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The problem with floating palettes is that they tend to get in the way of your work 

(the smaller your monitor, the more obtrusive palettes are). The good news is that you 

can move palettes around on the screen, collapse them to just a title bar, or close them 

completely. IF a floating palette is in your way and you want to see what is behind it, 

use one of the following methods: 

Move the palette. Move the palette by clicking and holding the left mouse button 

on the palette's title bar (the area on the top of the palette that shows the palette's 

name), dragging it to another location and releasing the mouse button. 

Collapse the palette. Collapse the palette so that you see only its title bar by 

double-clicking anywhere on the title bar or by clicking once on the Minimize button 

(the one that looks like a dash) in the upper-right comer of the palette. To expand the 

palette again, double-click anywhere on the title bar or click once on the Minimize 

button (the one that looks like a dash) in the upper-righ corner of the palette. 

Close the palette. Close the palette by clicking the Close button (the one that look 

like an X) in the upper-right corner of the palette. To reopen a palette, choose View=> 

Palette and select the palette you want to open from the list. (You can also reopen the 

Properties palette from your keyboard by pressing Ctrl+U.) 

4.2. The Object Tree 

As you add more elements to your Web page, identifying what is what on the 

page becomes harder and harder. The Object Tree provides an easy way to select any 

element on your page immediately. 

You can use the Object Tree both to select any element on your page and to see 

whether each element is part of the page's MasterBorder or Layout. 

The Object Tree shows you every element on your page and exactly what purpose 

it servers. If you add an element to the Layout portion of your page, that element 
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appears under the Layout name in the Object Tree. Likewise, if you add an element to 

the MasterBorder, that element instantly appears under the MasterBorder name in the 

Object Browser. 

Figure 4.1 shows the Object Tree. The icon on top indicates the name of the page 

that you are on, the icon beneath that one shows the name of the MasterBorder you are 

using, and the bottom most icon shows the name of the Layout you are using. 

Figure 4.1. The Object Tree Is Found Nowhere in Nature. 

When you click any element in the Object Tree, it is immediately selected on your 

page. IF you were to click on the Picture 67 icon in the Object Tree shown in Figure 

3.1, the Page view would automatically jump down to the bottom of the page and 

highlight the Built With NetObjects Fusion icon. You may also notice that the title bar 

on the Properties palette also changes. 

If a component contains other elements, that component appears in the Object 

Tree with either a plus or minus sign next to it. A minus sign indicates that the 

subelements (for lack of a better term) are displayed right below the element. A plus 
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sign indicates that the subelements are hidden on the Object Tree list. Clicking the 

Object Tree's plus sign displays subelements; clicking a minus sign hides subelements. 

You can also change the name that the Object Tree uses to identify a particular 

element, such as a graphic. To do that, just click the element in the Object Tree and then 

click a second time on the element's name. You are ready to type in a new name. Now 

any time you use that same element on any other page in your site, it appears in the 

Object Tree with its new name. 

4.3. The Properties Palette 

The Properties palette is like command central for controlling just about every 

aspect of an individual Web page. You use it to adjust the settings for virtually any 

aspect of your page, from the overall layout to a specific graphic. Make friends with the 

Properties palette now, and it will be your closest ally as you develop your Web site. 

Whenever you select an element (either by clicking the element on your Web page 

or by selecting the element in the Object Tree), the title bar on the Properties palette 

changes to show properties for the selected element, as shown in Figure 4.2. As you 

select different elements on your page, the Properties palette always changes to show 

the properties for that element. 

4.4. Layouts and MasterBorders 

Two important elements you can control from the Properties palette are the page 

Layout and the MasterBorder. If you look at Figure 4.3, you will notice a little gray box 

labeled MasterBorder in the upper-left corner of the page. Then down a little and to the 

right, you can see another gray box labeled Layout. The thin lines that extend from the 

gray box marked Layout form a box that defines your Layout area. The Layout area is 

where you place any elements - text, graphics, and so on - that are to appear only on 

this particular page. 
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Figure 4.2. The Properties Palette Changes According to What You Have Selected on 
the Page. 

Figure 4.3. Each Page Is Divided into a Layout Area and a MasterBorder Area. 

42 



Anything outside the Layout area is the MasterBorder. The MasterBorder is an 

area where you place elements that you want to appear on any page that uses the same 

MasterBorder. The MasterBorder works kind of like the header and footer in a word 

processing document, except that it can include the siders of a Web page as well as the 

top and bottom. 

4.5. Controlling Your Layouts 

A Layout is simply a combination of settings and content that controls the look of 

a particular page. (For example, background color is one such setting.) What makes 

NetObjects Fusion so powerful in this respect is that you can define several Layouts for 

the same page. What makes Layouts a little confusing is that any given Layout includes 

not only certain setting like background color, but also the content you add to your page 

while using that Layout. In other words, if you add, for example, some text to your page 

and then create a new Layout on that page, the text you added disappears until you 

switch back to the original Layout. 

When you publish your site, only the Layout current in use gets published for any 

given page. This means that using multiple layouts is useful not only for experimenting 

with various looks for the same page, but also with controlling variable content. For 

example, suppose you have a page that holds specific content for each day of the week. 

You could create a Layout for each day of the week, add the appropriate content for 

each Layout, and then publish the page daily using the appropriate Layout. 

You control several aspects of the page Layouts through the Properties palette. 

This section covers the more basic settings. 

Creating a New Layout, the ability to create multiple Layouts for the same page 

gives you an incredible amount of flexibility. You can experiment with a new look for 
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that page without fear of losing the old look. Because a Layout includes the content 

within the Layout area, you can store different content within the same page and change 

the published content of the page by simply selecting a different Layout. To create a 

new Layout, follow these steps: 

Click you mouse anywhere in the Layout area. Doing so changes the title of the 

Properties palette to Layout Properties. On the Properties palette, take note of the text 

field marked Layout Name. 

Click the down arrow by the Layout pull-down list located in the lower-left of the 

screen, as shown in Figure 4.4. 

Figure 4.4. In the Bottom-left Comer of Page View, You Can Find the Layout Pull
down List. 

A pull-down list includes the names of all available Layouts, plus the word Add. 

Select Add. The Layout name on the Properties palette changes to the name of the 

current page followed by the word Layout, all with no spaces. For example, if the name 

of your page is Home, the name of the new Layout is HomeLayout. This in itself can be 

a little confusing, because you may already have a Layout named, in this example, 

HomeLayout. For better or worse, NetObjects Fusion allows you to create multiple 

Layouts with the same name. Hence, the next order of business is changing the name of 

your new Layout. 
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Use your mouse to highlight HomeLayout in the Layout Name field on the 

Properties palette and then type a new for your Layout. 

You can use only standard alphanumeric characters with no spaces or punctuation. 

Notice that as you type in a new name, the Layout name changes in the Layout pull

down list at the bottom of the page, as well as in the Object Tree (assuming that the 

Object Tree is visible). 

4.6. Resizing Your Layout Area 

NetObjects Fusion lets you make each Layout a different size. This is handy if 

you are storing different content versions within your various Layouts and one version 

needs more room than another. To adjust the size of the Layout area, do the following: 

Click your mouse anywhere in the Layout area. Doing so changes the title of the 

Properties palette to Layout Properties. Note the fields marked Width and Height under 

the Layout heading, as shown in Figure 4-5. These fields display the current size of the 

Layout area in pixels. Also note that you are not allowed to change the setting listed 

under the Page heading. The reason is that the width and height of the page are 

determind by figuring in the dimensions of the Layout area, plus the dimensions of the 

Master Border. 

Change the width by either highlighting the current width and typing in a new 

number, or by clicking the small up and down arrows immediately to the right of the 

Width field. 

Change the height by either highlighting the current height and typing in a new 

number, or by clicking the small up and down arrows immediately to the right of the 

Height field. 
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Figure 4.5. You Can Change the Width and Height of the Layout Area, 
but Not of the Page. 

4.7. Coloring your Layout 

When it comes to the background color (the color that you see behind everything 

else on your page), you have three options. You can use the background color that is 

defined for the Style you are using, you can use some other color of your liking, or you 

can choose an image that is repeated across the entire length and width of the page. To 

change the background color, follow these steps: 

Click your mouse anywhere in the Layout area. Doing so change the title of the 

Properties palette to Layout Properties. 

Click the Background tab on the Properties palette. The palette gives you several 

options, as shown in Figure 4-6. To use the background color associated with the style 

you are using click the SiteStyle radio button. 

If you choose this option, you can skip the rest of these steps. If you want to use a 

background image instead of a solid color, you can skip to Step 7. 
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Figure 4.6. You Have Several Options for Your Background. 

To use an image for your background, click the Picture radio button. NetObjects 

Fusion displays an Image File Open dialog box. 

Navigate your computer to find the image you want to use for your background 

image. The image File Open dialog box works like any other Open dialog box in any 

other Windows program. Note that althrough Web pages use graphics that are in GIF or 

JPEG format only, NetObjects Fusion also lets you select files in the following formats: 

PNG, BMP, PCX, or PICT. If you choose a file in one of these alternate formats, 

NetObjects Fusion automatically creates a copy in GIF or JPEGformat for use on your 

site. 

Also note that the Image File Open dialog box includes a tab called Image Assets. 

If you click the Image Assets tab, you have the option to select a backgroung image 

from any of the image that you have already used anywhere in your site. Click the name 

of the file you want to use, and then click the Open button. The image you select is 

titled across the width and length of the page. 
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4.8. Sounding off in Your Layout 

NetObjects Fusion gives you the option to include a background sound on any 

Web page (and in fact, lets you include a different background sound for each Layout 

on a page). A background sound is one that plays immediately when the page is viewed 

in any late-model Web browser. But before you run off and add your recital of the 

Gettysburg Address as a background sound, keep in mind that the longer the sound, the 

bigger the file that contains it. And the bigger the file, the longer your page takes to 

load. Prior to adding a background sound, stop and consider whether the extra download 

time is really worth it. Sometimes it is; other times it is not. You can add a background 

sound by following these steps: 

Click the mouse anywhere in the Layout area. The title of the Properties palette 

changes to Layout Properties. 

Click the Background tab on the Properties palette. Doing so displays several 

options, including a Sound check box. 

Select the Sound check box. Click the Browse button. A standard Open dialog 

box appears. Navigate the folders of your hard disk to find the sound file you want to 

use for your background sound. NetObjects Fusion lets you use sound files in AIFF, 

AU, WAY, or MIDI format. However, not every Web browser can support every sound 

file format. Because AU files are the most common on the Web, I suggest you use this 

format for the greatest compatibility with the widest variety of Web browsers. 

Click the name of the file you want to use, and then click the Open button. You 

return to the Background Sound dialog box. If you want the sound to play continuously 

(versus just one time through) click the Continuous Loop check box. Click the OK 

button. Now people will not only see your Web page, but they will hear it, too. 
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4.9. Mastering MasterBorders 

A MasterBorder is the area of a NetObjects Fusion page outside the Layout area. 

You can place elements that you want to appear on more than one page in the 

MasterBorder. Much like Layouts, you can create or modify a MasterBorder on one 

page and then use it on any other pages in your Web site. For example, if you create a 

NavBar, you will probably want to put it in the MasterBorder and then use that same 

Master Border on other pages in the same hierarchical level. 

You can put just about anything - text, graphics, multimedia - in a MasterBorder, 

but you control the general characteristics or the MasterBorder from the Properties 

palette. 

Creating a New MasterBorder, just as with Layouts, your best bet is to create a 

new MasterBorder before you start fiddling with any settings. That way, if you find that 

the results of your MasterBorder experimentation are less than perfect, it is easy to 

revert to the old one. If you screw up on the new one, just select the old one and you are 

right back where you started. Follow these steps to create a new MasterBorder: 

Click your mouse anywhere in the MasterBorder area. The title of the Properties 

palette changes to MasterBorder Properties. Note that the Properties palette now has 

three tabs along the top, as shown in Figure 4.7. 

Click the Add/Edit button to the right of the MasterBorder name. An Edit 

Master Border List dialog box appears, as shown in Figure 4-8. 

From the pop-up list in this dialog box, select a MasterBorder as the base for your 

new one and then click OK. 
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Figure 4.7. The Properties Palette Changes to MasterBorder Properties. 

Figure 4.8. This List Shows All the MasterBorder that Are Currently Available. 

No matter what page you are on, you can pop up a list of all available 

Master Borders by clicking the little down arrow to the right of the MasterBorder name 

on the Properties palette. After the list pops up, just click the name of the MasterBorder 

you want to use. 
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4.10. Getting Marginal with MasterBorders 

Each portion of a MasterBorder - the top, bottom, right, and left - is called a 

margin. When you adjust the right or left margin, you affect the width of the entire 

page. When you change the top or bottom margin, you affect the page height. 

You can change MasterBorder margins by following these steps: 

Click your mouse anywhere in the MasterBorder area. Again, the title of the 

Properties palette changes to MasterBorder Properties. 

To change any one of the margins, either highlight the current size of that margin 

and type a new number or click the small up and down arrows to the right of the margin 

size to change the size one pixel at a time. 

I want to cover just a couple more goodies in this chapter. One is the tool palette 

that appears along the left side of your screen, and the other is a set of navigational 

buttons on the bottom of the screen. These buttons help you move from page to page 

when you are in Page view. 

You may not realize it, but the tool icons that you see along the left side of your 

screen are actually in two separate toolbars. One is called Standard Tools and the other 

is called Advanced Tools. You can hide and redisplay these by selecting the appropriate 

toolbar name from View=>Toolbars. 

The tools that I really want to focus on now are the Selection tool and the Zoom 

tool. The Selection tool is the one that looks like an arrow. As the name implies, its 

primary purpose is to select things. You select something by clicking it - this tells the 

program what item to perform the next operation on. 

One final comment on both the Standard Tools and Advanced Tools toolbars is. I 

like them where they are by default - along the left side of the screen. However, if you 

want, you can convert either or both to what amounts to floating palettes. To perform 
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this, just click and hold the outline of the toolbar which changes to horizontal 

orientation, at which time you can put the toolbar anywhere you want on the screen. To 

put it back, just drag it back to the left side of the screen. 

The Zoom tool enables you to zoom in and out, making the page appear larger or 

smaller on your computer screen. To use this tool, just give it a click - it is the one that 

looks like a magnifying glass. When the pointer turns into a magnifying glass with a 

plus sign in the middle, click the part of the page that you want to enable. 

If you find that you have zoomed in too far, you can hold down the Alt key and 

use the Zoom tool to zoom back out. Notice that when you hold down the Alt key, the 

plus sign in the middle of the magnifying glass turns into a minus sign. Earlier versions 

of NetObjects Fusion provided separate Zoom In and Zoom Out tools. One final note on 

zooming: Instead of using the Zoom tool to zoom in and out, you can also choose 

View=:> Zoom. 

Moving Around, I also want to discuss the five little buttons near the lower-left 

comer of your screen. They look like an up arrow, a down arrow, a left arrow, a right 

arrow, and one botton that has arrows pointing in all directions. If you cannot find them, 

take a look at Figure 4.9. From left to right - Navigation Buttons. 

Figure 4.9. The Navigational Tools in the Lower-left Comer. 
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Takes you to the page immediately above the current page in the site's hierarchy. 

If you do not have a page above the current page (that is, if you are looking at the home 

page), this button does not do anything. 

Takes you to the page immediately below the current page, in the site's hierarchy. 

Takes you to the page immediately to the left of the current page, as displayed in Site 

view. 

Takes you the page immediately to the right of the current page, as displayed in 

Site view. Pops up a mini Site view window, like the one shown in Figure 4-10. Use 

this window to select where you want to go. 
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Figure 4.10. You Can See a Mini Version of the Site View. 

4.11. Getting the Word Out with Text 

The words you present are the most important elements on your Web page. Sure, 

nice graphics look cool and snappy multimedia makes you say "Wow," but the majority 

of people surf the Web to find some sort of information. For better or worse, that puts 

you in the information business. 

Just as important as what you say, however, is the way you present your message. 

If your Web page consists of plain Courier text against a plain gray background, people 
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are going to get plain bored with your Web site, even if your site holds the answers. 

Your message needs to be solid and your copy needs to be well edited, but your text 

also needs to look attractive. Once again, NetObjects Fusion comes to the rescue. With 

a couple of mouse-clicks here and there, your boring text becomes a virtual work of art! 

Adding Text to Your Page 

NetObjects Fusion differs from most Web authoring programs in the way it 

handles text. Most Web authoring programs work like word processing programs: You 

type top to bottom, and if you want to type text at the bottom of a page, you have to 

start at the top and keep typing until you reach the bottom. NetObjects Fusion gives you 

control over how your text is positioned and, unlike the typical Web authoring 

programs, NetObjects Fusion lets you position independent blocks of text on a page. In 

fact, in this respect, NetObjects Fusion works very much like QuarkXpress: First you 

create a text box, and then you type something in it. 

Boxing Your Text 

Unlike other Web authoring programs, NetObjects Fusion lets you create 

individual text boxes, fill them up with text, and move them around on your Web page, 

independent of each other or anything else. 

The first step, then, in adding text to a page is creating a text box. To create one, 

make sure you are in Page view on the page where you want to add some text and then 

follow these steps: 

Click the Text tool in the Standard Tools palette on the left side of your screen. 

This is the Text tool that contains the letter A. If the Standard Tools palette is not 

displayed, choose View=> Tool bars=:> Standard Tools to bring it up. After you select the 

Text tool, notice that the mouse pointer turns into a crosshair. 
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Position the crosshair at any one of the four corners of your intended text box. 

You can use the grids that appear on the page to help you identify the area for the text 

box and position the cursor. It is important to realize that these grid lines do not appear 

on your finished Web page. In fact, you can hide the grid lines at any time by pressing 

Ctrl+D or unchecking Grid in the View menu. Also, although you can actually start out 

at any corner, your best bet is to start in the upper-left corner, because that is where you 

start typing after you create the text box. 

Click and hold your left mouse button, and then drag the crosshair to the opposite 

corner of the imaginary box to define a real text box. As you drag, a dotted line appears 

around the area you are defining. 

Release the mouse button. A new text box appears in the area you defined, with 

the text cursor blinking in the upper-left corner. Figure 4.11 shows the text box (but 

unfortunately, on paper I cannot show you the blinking cursor). 

Figure 4.11. Now You Are Ready to Start Typing. 

Type the desired text into the text box. When you finish typing, click the mouse 

anywhere else on the page and the etxt box becomes deselected. If you did not fill up 

the entire box with text, it automatically resizes itself. 
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If you ever need to change any of the text, you have two ways to get back into the 

text box. If you already have the Text tool selected, just click once anywhere in the text 

box. If you are using the Selection tool, double-click the text box to edit its text. 

Wrapping Up Your Box 

Of course you can do all sorts of things to affect the appearance of the text in your 

text box. However, NetObjects Fusion lets you treat each text box as a separate page 

element. That means that there are certain characteristics that you can apply to the text 

box as a whole. If you click once on a text box with the Selection tool, the Properties 

palette shows you some options marked Text Box, as shown in Figure 4.12. 

Here is what these options do: 

Background Color. Clicking the Color button brings up a color palette. Click the 

color that you want to appear inside your text box. 

Text inset. This option controls the distance between the edge of a text box and its 

contents. It helps you keep the text box from looking cramped. 

Figure 4.12. You Have Couple of Options for a Text Box. 
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Look Size. This option lets you lock the size of the text box, preventing it from 

automatically adjusting its size according to its contents. This is handy if you are going 

to be changing the text in that box regularly and want to make sure the text box takes up 

the same space on the page every time you modify it. 

Size to Layout. Clicking this check box automatically resizes the text box to fill 

the entire layout area. Text Box Is a Form. This option makes NetObjects Fusion treat 

the text as a form. 

4.12. Touching up Your Text 

When I was a student, I had to type my book reports on a manual typewriter. If I 

wanted bold type, I had to backspace and retype the word. Thanks to computers, now all 

this special formatting stuff is a snap. That is a good thing and a bad thing. It is a good 

thing because special formatting, when used sparingly, can really drive a point home. It 

is a bad thing because it is so easy that it tempts you to go overboard. 

Right now, you should be in Page view. The page you are viewing should have a 

text box on it, and you should see some text in that box. You should also have the 

Properties palette displayed. Now, on with the procedures. To add special formatting to 

text, just follow these steps: 

Using the Selection tool, double-click the text box that contains the text to be 

formatted. This makes the text box active and positions the text cursor wherever you 

happened to double-click. I call this active edit mode. 

Use your mouse to highlight the portion of text to which you want to apply special 

formatting. 

With the text still highlighted, click one of the special formatting buttons on the 

Properties palette, as shown in Figure 4.13. 
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Figure 4.13. Click One of These Buttons to Change the Appearance of Your Text. 

Keep in mind that you can apply more than one type of special formatting to a text 

selection. 

4.13. Adjusting Type Size 

NetObjects Fusion gives you the maximum control possible over fonts and type 

size. To change your type size, step through the following:Using the Selection tool, 

double-click the text box that contains the text to be changed.Use your mouse to 

highlight the portion of text that you want to change the size of. 

With the text still highlighted, click the down arrow just to the right of the Size 

field on the Properties palette. Click the desired text size from the list. 

Changing the Font 

NetObjects Fusion lets you choose specific fonts to include on your Web page. 

Although the use of specific fonts is not an official part of HTML - the current versions 

of both Navigator and Internet Explorer recognize instructions to use specific fonts 

when displaying a Web page. That means that you can use any font on your system to 
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create your Web page. If you want to change a font on your Web page, follow these 

steps: 

Using the Selection tool, double-click the text box that contains the text to be 

changed. This puts the text box in edit mode and changes the Properties palette to Text 

Properties. 

Use your mouse to highlight the portion of text whose font you want to change. 

With the text still highlight, click the down arrow just to the right of the Font field on 

the Properties palette. This pull down a list of your possible font choices. Click the 

desired font from the list. 

NetObject Fusion colors your text according to whatever Style you happen to use. 

Text coloring can come in handy when you alter the color of an entire text block to set it 

off from other text blocks on the page. For example, if you have a small block of text 

providing extra information about the text in the main body of the page, you may want 

to change the color of that text. To change the color of the text, again start out in Page 

view and follow these steps: 

Using the Selection tool, double-click the text box that contains the text to be 

recolored. This puts the text box in edit mode and changes the Properties palette to Text 

Properties. 

One of the radio buttons is the SiteStyle button; the other just has a colored box 

next to it. When you check the SiteStyle radio button, text color is set according to the 

Style you use. When you choose an alternate color, NetObjects Fusion selects the 

unmarked radio button for you. 
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Figure 4.14. These Options Control the Color of Your Text. 

Use your mouse to highlight the portion of text for which you want to change the 

color. With the text still highlighted, click the Color button to the right of the two radio 

buttons. This pops up a standard Color palette that shows the colors you can choose 

from. Click the color you want and then click OK. 

4.14. Using Graphic in Web Page 

NetObjects Fusion inserts quite a few graphics in your page for you. NavBars and 

other SiteStyle elements are graphic images. By using only these graphics, you could 

probably come up with a reasonably attractive Web page. Chances are that you already 

have company logos, product pictures, employee photos, and so on waiting to find 

homes somewhere in your Web site. Plus, NetObjects Fusion offers some of its own 

basic tools that you can use to create additional graphic elements on your Web pages. 

Computer graphics have more file formats. Photoshop (the industry-leading 

image-manipulation program from Adobe) offers 16 different file format options in 

additional to its own proprietary format. Furthermore, many formats offer subformats, 
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for lack of a better term. For example, when saving a file as a TIFF (Tagged Image File 

Format), you have the option to save the image as a regular TIFF or as a compressed 

TIFF. 

The World Wide Web simplifies graphic file formats somewhat by limiting your 

choices. Traditionally, the Web has only supported two graphic formats: GIF (Graphic 

Interchange Format) and JPEG (Joint Photographic Experts Group). Typically, you use 

JPEG for photographic image because JPEGs are capable of 24-bit, photorealistic color, 

and you use GIF for everything else. GIF are capable of any 8-bit color, so they are not 

well suited for photographic images. 

GIF and JPEG formats have served the Web well for two reasons. First, both 

formats are widely used across all computing platforms. Other formats, like PCX (for 

Windows) and PICT (for Mac) do not usually find their way outside their respective 

platforms. Second, both formats are compressed formats, meaning that they scrunch the 

image information to produce smaller file sizes. 

Smaller file sizes translate into faster download times for you Web pages. For 

example, I just converted a lOK JPEG image to an uncompressed TIFF, the result of 

which was a 50K file. Going from lOK to 50K may not seem like a big deal, but it is a 

factor of five. If the JPEG had started out at 50K, the resulting TIFF would have been 

250K. That is a big difference. 

Almost everyone believed GIF to be a freely usable format for years, given as a 

gift to the world by the online service CompuServe. Then, a couple of years ago, Unisys 

Corp. decided that because it had developed the compression technology used in the 

GIF format, Unisys should be entitled to royalties from any program that supports the 

GIF format. 
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JPEG and GIF may be all well and good for the Web, but chances are that the 

existing graphics you want to put on your Web page are in some other format. Now 

what? The answer depends on exactly what format they are in. 

If your existing graphics are in BMP, PCX, or PICT format, you are in luck 

NetObjects Fusion can convert images in these formats into either JPEGs or GIFs for 

you as you put them on your Web page. 

If you have graphics that are in any other format, you have to convert them to GIF 

or JPEG on your own. I do my converting in Corel PhotoPaint. However, I have seen 

utility programs in software catalogs that are designed to handle such conversions. 

If you are on a budget, you may want to consider the shareware alternative. For 

example, at the time of this writing, the ever-popular Paint Shop Pro is on Version 5.x. 

This latest version supports just about every format you can imagine, including PNG. 

You can find it on Shareware.com (located conveniently at www.shareware.com). 

Dipping into Your Personal Gallery 

Say that you have a graphic on your hard drive that you want to use on your Web 

page. The graphic is already saved as a JPEG, GIF, or PNG (which NetObjects Fusion 

can convert to GIF or JPEG for you). What next? 

Getting your graphics onto your Web page is easy, but that is only the beginning. 

You can do a whole bunch of other cool stuff with the graphic after you get it on your 

page. In this section, explain how to put graphic on your page and what you can do with 

them after they are there. 

Graphic Insertion 

Whether you are placing a native Web graphic or one that NetObjects Fusion has 

to convert for you, you use the same basic steps. The steps that follow assume that you 

are already in Page view, the Standard Tools palette is showing, and you have some 
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idea where on the page you want to put your graphic. To put a graphic on your Web 

page, just follow these steps: 

Click once on the Picture tool (just below the Text tool) in the Standard Tools 

palette. The mouse pointer turns into a crosshair. 

Click and hold your left mouse button; then drag the crosshair to form a box inti 

which NetObjects Fusion will insert your graphic. 

As you drag, a dotted line appears around the area you are defining. You do not 

have to worry about precision when it comes to the size and shape of the box. After you 

choose a graphic, NetObjects Fusion automatically adjusts the size of the box to the 

exact size of the graphic. 

Release the mouse button. An Image File Open dialog box appears on your 

screen, as shown in Figure 4.15. If no dialog box appears, you probably tried to place a 

graphic where one does not belong. For example, you cannot place a graphic partially in 

the Layout area (the content area unique to any given page) and partially in the 

MasterBorder (the content area shared by many pages). 

Notice that the Image File Open dialog box has two tabs: Folders (which you are 

on now) and Image Assets. After you place a graphic on any Web page in your site, it 

becomes an asset. The next time you want to use a graphic that is defined as an asset, 

you can click on the Image Assets tab and select the graphic from the list. Doing so 

saves you the trouble of navigating through your system to find the graphic. 
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Figure 4.15. Time to Locate Your Graphic. 

If the image you want to insert is not a GIF, JPEG, or PNG, click the Files of 

Type field and select the correct file format. Navigate through your system to locate the 

graphic file that you want. 

When the filename appears in the dialog box, click the filename once and then 

click Open. 

If your file type is GIF or JPEG, you are done. If you inserted a PNG, BMP, PCX, 

or PICT file, you have one more step to go. NetObjects Fusion warns you that the 

original file format is not recognized by most Web browsers and asks you whether you 

want to convert the file and store it as GIF or JPEG, just like in Figure 4.16. About the 

only time you would choose not to keep it in that format. 
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Figure 4.16. You Get to Choose Between GIF or JPEG. 

Click on the file format you want and then click OK. You can Move the image 

around by simply clicking and dragging. Delete the image by selecting it with the 

Selection tool and then pressing the Delete key. Replace the image with a different 

graphic by clicking the Browse button in the Picture Properties palette (see Figure 4.17) 

and selecting a different file. 

Figure 4.17. You Can Control Many Aspects of a Graphic's Appearance. 
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You should do one more thing for the graphically impaired Web surfer. Direct 

your attention to the Alt Tag field in the Picture Properties palette. In the interest of 

saving time, some people turn the graphics viewing option off on their Web browsers. 

Although this step speeds up Web surfing, people have no idea what graphics they are 

missing - unless you type an Alt Tag. An Alt Tag is a line of text that appears in place 

of graphic when graphic viewing is turned off. This field is not required, so whether you 

use it or not is entirely up to you; it is not required. 

4.15. Adding Special Image Effects 

When you select a graphic on your Web page, the Effects tab on the Properties 

palette offers three options that you can use to further fine-tune the appearance of your 

graphic: Transparency, Text in Element, and Rotate. 

Making Colors Transparent 

Choosing the Transparent option on the Properties palette's Effects tab lets you 

make one - and only one - color in a GIF (not a JPEG or PNG) image transparent when 

viewed with a Web browser. This feature comes in handy if you want to place an odd-

shaped image over the background on your page. For example, Figure 4-18 shows two 

copies of the same image, one with no transparency and the other with. You can see that 

the background color in the first image would obscure the Web page's background. The 

problem is solved with the second image. 

Figure 4.18. The First Image Uses No Transparency; the Second Does. 
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You have to be careful with transparency. When you make a particular color 

transparent, every occurrence of that color within that graphic becomes transparent. For 

example, suppose you have a picture of a man in a white shirt, with white also as the 

background color. If you make white transparent, the background becomes transparent, 

but so does the white area of the man's shirt. To use the Transparency option, follow 

these steps: 

Select a GIF image that you are added to your Web page. Click the Effects tab on 

the Properties palette; then click the Eyedropper button in the Transparency panel. Note 

that the mouse pointer turns into an eyedropper. 

Within the graphic, click the eyedropper on whatever color you want to make 

transparent. The color bar on the Properties palette changes to the color you clicked on. 

Click the Use Color check box next to the eyedropper button. When you look 

back at your GIF image, the color you specified is invisible. 

Adding Text to Graphics 

Making text into a graphic is also handy if you design a graphic that you want to 

use as some sort of link button. To add text to a graphic, follow these steps: 

Select the graphic to which you want to add text. Click the Effects tab on the 

Properties palette. 

In the Text in Element area, click the Enable check box. The words Your text here 

appear over your graphic. Click the Setting button to the right of the Enable check box. 

The text in Element Settings dialog box appears, as shown in Figure 4.19. 

Type the text you want, make any adjustments to the settings, and then click the 

Close button. 
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4.16. Creating Hypertext Links 

Creating hypertext links in your documents is a decidedly cool thing to do. Used 

correctly, hypertext links help readers find the information they are looking for. Just 

because you can create links, do not feel that you have to provide hypertext links to 

every site on the Web that has some possible relevance to your site. You main purpose 

is to provide information and to keep people at your site for as long as possible. 
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Figure 4.19. You Can Control Exactly How the Text Appears with the Graphic. 

When you select a portion of text to serve as a hypertext link, NetObjects Fusion 

offers you four different choices for the type of link you want to create. 

An Internal Link is simply a link to another page on your site, and optionally an 

anchor on that page. 
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A Smart Link is a relative link. For example, one of the options for a Smart Link 

is up. If you select this option, NetObjects Fusion figures out for you which page is one 

level up in the hierarchy and creates the appropriate link. 

An External Link is a link to any page outside your site. Once you type in a Web 

address for an External Link, it becomes an Asset. You never have to type it again. The 

next time you need it, you can select it from a list. 

A File Link is a link to a file that you created in some other program besides 

NetObjects Fusion. For example, you can use this option to create a link to ZIP or EXE 

file that users can download from your site. The good news is that no matter where the 

file currently resides on your hard drive, NetObjects Fusion will include the file when it 

publishes your site, and adjust the link according to where it places the file. 

Adding internal text links 

An internal link is simply a link to some other page on your site. While NavBars 

create internal links to pages related to each other in your site's hierarchy, you can 

create your own internal link to any other page on your site, no matter where it lies in 

the hierarchy. To create an internal link, just cruise through these steps. 

Use your mouse to select the word or words you want to serve as the link. The 

Properties palette switches to Text Properties. 

Click the Link button in the lower-left corner of the Properties palette. A Link 

dialog box appears on your screen, as shown in Figure 4.20. This dialog box has four 

tabs: Internal Link, Smart Link, External Link, and File Link. NetObjects Fusion always 

starts you out on the Internal Link tab. 

The center of this dialog box contains a list of all the pages that are currently part 

of your site. Perhaps you are wondering why there is also a radio button marked Current 
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Page, and more specifically why you would want to create a link to the page you are 

already on. You use this option in conjunction with anchors. 

Click once on the page to which you want to link, then click the link button at the 

bottom of the dialog box. 

Figure 4.20. The Link Dialog Box Offers a Separate Tab for Each Type of Link. 

NetObjects Fusion provides a quick and easy way to add a link to a page that has 

some direct relation to the current page (even if you do not know the name of the page 

you want to link to). Using the Smart Link feature, all you have to do is decide whether 

you want to link to the next page in the hierarchy, the first child page under the current 

page, or your home page. NetObjects Fusion handles the rest. 

Use your mouse to select the words you want to serve as the link. The Properties 

palette switches to Text Properties. 
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Click the Link button in the lower left corner of the Properties palette. A link 

dialog box appears on your screen. 

Click the Smart Link tab. See Figure 4.21 for an example of the Smart Link tab. 

Figure 4.21. You Have Four Smart Links to Choose from. 

Click once on the desired Smart Link, then click the Link button at the bottom of 

the dialog box. 

Adding External Links, an external link is a link to anything other than a page on your 

site. Here are the steps for creating an external link. 

Use your mouse to select the words you want to serve as the link. The Properties 

palette switches to Text Properties. 

Click the Link button in the lower-left corner of the Properties palette. A link 

dialog box appears on your screen. 

71 



-··•-c. ·-·~·- ' 
" 

·. , . . --- -. ',.,.' 
'' ' 

Click the External Link tab. Select the correct URL type and then type in the 

remainder of the Internet address for this link. 

Type the name you want to assign to this link into the Asset Name field and click 

the link button at the bottom of this dialog box. 

Adding a File Link 

A file link is a link to a non-HTML file. For example, suppose you have created a 

program you want users to download from your site. You can create a file link to the 

program; clicking on the link then initiates the download of that file. Follow these steps 

to create a file link. 

Use your mouse to select the words you want to serve as the link. Click the Link 

button in the lower left comer of the Properties palette. A link dialog box appears on 

your screen. 

Click the File Link tab. Select the desired file, then click the link button at the 

bottom of the dialog box. 
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V. FIND THE WEB SERVER AND PUBLISHING YOUR SITE 

After you finished creating your Web site, now you have to find a home for your 

site on the Internet. You can benefit from investing some time exploring several 

different ISPs (Internet Service Provider). ISPs vary widely in the cost, quality, and 

services they offer. 

5.1. Owning Your Domain Name 

Before you even go shopping for an ISP, you need to decide whether you want 

your site to use its own domain name. A domain name is the unique Internet name used 

to identify you or your company. For example, the domain name for my Web site is jj

market.com. Each domain name includes the unique part that identifies you, plus a 

suffix. The important thing to keep in mind is that your domain name includes the 

suffix. For example, even though jj-market.com is registered to my company, some 

other company could come along and register jj-market.net. 

Domain Name Possibilities 

Suffix 

.com 

.net 

.org 

.gov 

Use 

The most common suffix; used by companies 

Used by companies and individuals; most common among 

Internet related businesses 

Used by nonprofit and noncommercial organizations 

Used by government agencies 

Having your own domain name, instead of relying on your ISP's domain name, is 

important for two reasons. First, it makes your Web address much simpler to remember. 

For example, to visit my Web site, you type in http:Uwww.jj-market.com. On the other 

hand, ifl relied on my ISP's domain name for access to my site, the Web address would 

be something like www.hostnow.com/users/-jj-market. The second reason to use your 

73 



own domain name is that you get to keep your domain name forever. If you rely on your 

ISP for a domain name, what happens if you decide to switch to a different ISP? Your 

Web address changes, too. Any stationary you printed with your Web address goes in 

the trash and people who have bookmarked your site can suddenly no longer find you. 

That is not good. No matter what ISPs come and go, and no matter how many times you 

switch ISPs, if you have your own domain name, that domain name is yours. You can 

take it with you anywhere you want. 

5.2. Registering Your Domain Name 

To claim ownership to a domain name, you need to regiser it. Today in the United 

Sates, all domain names are registered by a company called InterNIC (see Appendix B 

for more detail), but for Thailand it is an organization called ThaiNIC (see Appendix 

A.) You can check to see if the domain name you want is registered already by visiting 

the InterNIC Web site at www.internic.com. 

To register a domain name, you simply complete an e-mail-based form available 

from InterNIC and send it in. The computer system at InterNIC automatically finishes 

the registration process, spitting you back a rejection notice if there was a problem or a 

bill if everything went okay. IF you do not pay the bill within a certain period of time, 

your domain name gets tossed back in the "unused". 

Some ISPs can help you register your domain name. IF you have an ISP to help 

you out with this, make sure that your domain name is really registered to you and not 

to the ISP. 

5.3. How Much Should You Pay? 

If you have looked around much for a personal Internet account, you know that 

prices seem pretty consistent from one ISP to the next. For about $20 a month, you can 
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find unlimited Internet access and maybe 5MB of disk space for a personal Web page. 

Some ISPs go as low as $9 a month if you pay for a year up front. 

At these low prices, a small local company is not making a ton of money on 

personal accounts. This is known as a loss-leader - a low price, high-profile product 

that draws people in and popularizes the business. Many of these local ISPs make their 

real bread and butter from business accounts. If you are looking for a place to house 

your business related Web site, make sure you check the ISP's business rates. 

While most ISPs offer personal accounts in the $20 range, prices for business 

accounta are all over the map. For example, when my partner and I first registered .ti-

market.com, we went with a very popular ISP. We were paying more than $60 a month 

for Internet service and because we had not shopped around, we did not think much of 

it. The ISPs provided an itemized list of where all our money was going. Later on, I 

found a new site listing of most popular ISPs, I was shocked that some of the best 

I 

companies in the rank charged their customers just $15 a month. 

I have listed all ISPs for you to consider in the Appendix C, or you may go 

directly to the Web page for recent information. 

5.4. Price After the Initial Setup 

Many ISPs also impose traffic charges. Traffic refers to the amount of 

information, measured in megabytes, that outside users request from your Web site. 

Many ISPs allow you so much traffic per month, and then charge you extra if you go 

over. For example, if someone loads a page from your site that contains lMB of 

information (a rather large page, I realize), they have just used up lMB of your monthly 

allotment. 

A monthly traffic limit is just an arbitrary number determined by the ISP. Your 

ISP' s expenses do not go up in any measurable amount when your site goes over its 
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limit by, for example, lOMB. You need to have an incredibly popular site to create a 

major impact on your ISP's system. Your best bet is to find an ISP that does not nail 

you for any traffic charges. 

5.5. What to Expect for Your Money 

You need to figure out ahead of time exactly what services you need and do not 

need. Then compare prices from several ISPs. For me, right now I pay $19 a month. I 

get space for my Web site, virtual domain name hosting, and two access accounts - one 

for me and one for my partner. If you are developing a big commercial site and you 

need extras like credit card authorization, shopping cart software, and secure forms, you 

probably have to pay more than I do. 

Deciding Which Extras You Need 

Internet service is just like any other product. No two companies offer the same 

services for the same price. If you find two ISPs that offer similar packages at a similar 

price, you may need to look at the little extras that may or may not be of interest to you. 

For example, many ISPs offer predesigned CGI scripts that you can access and 

incorporate into your Web site without the need to hire a CGI programmer or know any 

CGI programming yourself. 

Many ISPs boast of their multiple Tl or T3 phone lines, the implication being that 

people will be able to access your site much more quickly that with some other ISP. I 

suppose that in general terms it is true that the more high speed phone lines, the better. 

Keep in mind that no matter how much bandwidth a particular ISP offers, it has to be 

shared with everyone using that ISP and therefore may give you even slower access 

times. 

The best way to determine response time is to check it for yourself. Visit other 

Web sites hosted by each ISP you are considering and see if you are satisfied with the 
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response times from those sites. Make sure that you do your exploring during peak 

business hours. If you go poking around at 2 a.m., even the lamest ISP is likely to clock 

in with a reasonable response time. 

5.6. What to Do When You Have Signed with the Wrong ISP 

Even after you have completed the most diligent of searches, you may find 

yourself with an ISP that does not live up to your expectations for one reason or 

another. Do not worry. As long as you are using your own domain name - this is not a 

major problem. 

If you are using your ISP's domain name and you switch, you may encounter 

several problems. First, if someone uses a search engine, finds a link to your old Web 

address, and discovers the link is dead, they may think your venture is dead, too. You 

will have to spend plenty of time resubmitting to search engines. Also, if you have had 

your Web address printed on any stationary, you will have a nice, big pile of stuff for 

the recycle box. 

Here are the steps to follow if you ever need to switch ISPs. 

(1) Contact the new ISP and let them know that you are switching over. 

(2) Set up an account with the new ISP. 

(3) Upload your site to the new ISP so it is ready when the domain name 

switches over. 

(4) E-mail a change form to InterNIC, available from the InterNIC Web site. As 

long as you complete the change form correctly, your domain name should 

get switched over in about 48 hours. 

(5) Cancel your account with your old ISP. 

This may seem like a bit of a hassle, but in the long run, it is worth it to be with an 

ISP that makes you happy. 
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5.7. Publishing Your Site 

Today, Web authoring programs like NetObjects Fusion handle all the file 

uploading for you. You do not need a separate FTP program and, more importantly, you 

do not need to know where to place different files. NetObjects Fusion takes care of all 

this stuff for you. 

One thing that makes publishing a NetObjects Fusion Web site different from 

publishing any other site is that prior to publishing your site, NetObjects Fusion saves 

your files in its own efficient format that only NetObjects Fusion can read. During the 

publishing process, NetObjects Fusion goes through the site and creates the HTML 

code. So until you publish your site, nobody except other NetObjects Fusion users can 

see your masterpiece. 

5.8. The Publish View Exposed 

The Publish view handles all your publishing tasks. To get to the Publish view, 

just click the publish button on the button bar across the top of your screen. When you 

do, NetObjects Fusion displays a list of all the elements that make up your Web site. It 

looks something like the one in Figure 5.1. 

Here is an overview of the various columns in this list. The Directory Structure 

column shows the basic directory structure of your entire site. As with the Windows 

Explorer in Windows 95, you can click a folder in the Directory Structure column to 

display its contents on the right side of the screen. 

The Name column displays the filename of each element. If you want to make a 

last-minute name change, just triple-click the current name to go into an edit mode. 

Next, change the name to whatever you want. 
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Figure 5.1. NetObjects Fusion Shows You a List of Everything It Plans to Publish. 

The Attributes column indicates whether the element has any of two special 

attributes. For example marks it with a C for customized. The site you see in Figure 5-1 

was imported from an existing HTML site, so many file have a C mark. The other 

attribute marker is R, which stands for read-only. These are usually files that NetObjects 

Fusion has generated automatically, such as a SiteMap page, and therefore you cannot 

change them manually. 

The Last Remote Publish column displays the date that each element was last 

published on a remote server - that is, somewhere other than on your own computer. If 

this is your first time publishing, the column reads Never Published. 
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The Last Local Publish column displays the date that each element was last 

published on your own computer. If this is your first time publishing the column reads 

Never Published. 

5.9. Setting the Stage 

Before you can publish your Web site, NetObjects Fusion needs to know a few 

details about exactly how you want the program to handle certain aspects of the 

publishing operation. Specifically, NetObjects Fusion needs to know. How you want the 

directory structure managed on the published site. Whether you want the site published 

by using nested tables, standard tables, or CSS (Cascading Style Sheet) positioning. 

Where you want the site published 

Organizing Your Site: Structural Choices 

N etObjects Fusion gives you three choices for organizing the files that make up 

your published site. Here is a description of each. 

By Site Section. This option makes NetObjects Fusion put all the files from each 

section of your site into a separate folder. 

By Asset Type. This option causes NetObjects Fusion to put all your HTML files 

in one folder and all your other files in a separate folder. Flat. This option puts all your 

files in the same folder. Which option you choose has absolutely no effect on the end 

user. You base your choice solely on what you expect to find more convenient if you 

ever have to connect to your Web server via FTP program and manipulate some of the 

files manually (like that time you accidentally deleted the company logo from your hard 

drive, and needed to retrieve a copy from the Web server). Here is how to set the site 

structure for your publish site. 

Click the Publish button on the button bar across the top of your screen to get to 

the Publish view. 
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In Publish view, click the Setup button on the button bar at the top of the screen. 

After you click the Set up button, NetObjects Fusion displays a Publish Setup dialog 

box like the one shown in Figure 5-2. This dialog box defaults to the Directory 

Structure tab. 

Click the down arrow to the right of the Directory Structure field to display the 

list of options. 

Click the desired option. Click the OK button. Before your very eyes, the Publish 

view changes to reflect the site structure that you specified. 

Figure 5.2. Go Here to Control How NetObjects Fusion Generates Your HTML. 
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5.10. Where to Publish Your Web Site 

Perhaps the most important information NetObjects Fusion needs to know about 

your site is where to publish it. NetObjects Fusion can publish your site locally (on your 

hard drive or another computer that is on your immediate network) or remotely (on a 

Web server that you connect to over the Internet). 

Normally, you will want to publish your site locally so you can test it on your own 

system and then publish remotely for the rest of the world. The steps are a little different 

for each. 

NetObjects Fusion also offers a couple of options that you can set for each 

possible location. 

You can have NetObjects Fusion automatically change the name of the main page 

in each folder to index, default, home or many name of your choosing. 

You can have NetObjects Fusion use any one of the following extensions for your 

HTML files: html, htm, or shtml. (Some servers use the shtml extension to indicate 

secured (encrypted) form pages.) Note that you can also specify any other extension of 

your choosing. 

You can have NetObjects Fusion convert any spaces or other unallowable 

characters in your file names to underscores. I highly recommend this. 

Testing Locally 

To set up your site for publishing locally (so that you can test it), follow these 

steps. 

In the Publish view, click the Setup button on the button bar at the top of the 

screen, and then click the Server Locations tab in the resulting Publish Setup dialog 

box. NetObjects Fusion displays two choices, as you see in Figure 5.3. 
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Figure 5.3. You Can Publish Your Site in Different Locations. 

Click My Computer and then click the Edit button. A Location Properties dialog 

box appears, as shown in Figure 5.4. 

If desired, change the Server Name to something that better describes the server. 

If desired, click the Browse button to navigate your computer and select an alternative 

folder for local publishing. The default, Local Publish, is a subfolder of the folder in 

which your site NetObjects Fusion files reside. 

If you want, change the name of each main page by using the Rename Home Page 

of Each Directory As field. You can select one of the common names from the pop-up 

list or type any name you want in this field. 
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Figure 5.4. You Need to Tell NetObjects Fusion Where to Go. 

If you want, change the default extension for your HTML files by using the Make 

the Extension of Each Page field. You can select one of the common extension from the 

pop-up list or type any extension you want in this field. If you type your own, just 

remember to start it with a period. 

Click the OK button. Doing so takes you back to the previous dialog box. Click 

the OK button again. Publishing Globally 

Setting up your site for remote publishing requires a little more information than 

doing it for local publishing. Chances are, you will need to get this information from 

your system administration or your ISP, as appropriate. Specifically, you need. 
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The name of the remote server to which you upload your files. This is something 

similar to ftp.mvserver.com. 

The name of the directory into which your files should be placed. This is called 

the target or base directory. Figuring out the target directory can be tricky, because 

some ISPs set up a virtual server for you. For example, to upload my site, I connect to 

ftp.jj-market.com (my domain name) instead of ftp.hostnow.com (my ISP's domain 

name). This being the case, I do not need to enter any directory name. Make sure that 

you check on this when you talk to your system administrator or ISP. 

The username and password to connect to your Web server via FTP. If you do not 

know this information, find out now and then keep it in a safe place. To set up your site 

for publishing on a remote server, follow these steps. 

In the Publish view, click the Setup button on the button bar at the top of the 

screen, and then click the Server Locations tab in the resulting Publish Setup dialog 

box. NetObjects Fusion displays two choices: My Computer and Remote Publish 

Server. 

Click Remote Publish Server and then click the Edit button. A location Properties 

dialog box appears, as you see in Figure 5.5. 

If you want, change the Server Name to one of your liking. Type the name of the 

.remote server in the Remote Host field. 
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Figure 5.5. NetObjects Fusion Needs Some Instructions to Get Your Site 
Where It Is Going. 

If necessary, type the name of the target directory in the Base Directory field. If 

you do need to enter a directory name, you do not need to use a slash unless you are 

specifying a subdirectory. For example, if the target directory is named myfiles, just 

type myfiles. However, if the target directory is a subdirectory of myfiles named test, 

type myfiles/test. You may want to specify a subdirectory to publish your site remotely 

for testing. 

Type your usemame in the Name filed. Type your password in the Password field. 

I recommend that you leave the Remember Password check box checked so that you do 

not have to retype it each time you upload your site. If desired, change the name of each 
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main page by using the Rename Home Page of Each Directory As field. You can either 

select one of the common names from the pop-up list or type any name you want in this 

field. (This choice is largely a matter of personal preference.) If desired, change the 

default extension for your HTML files by using the Make the Extension of Each Page 

field. You can either select one of the common extensions from the pop-up list or type 

any extension you want in this field. If you type your own, just remember to start it with 

a period. 

Click the OK button. Doing so takes you back to the previous dialog box. Click 

the OK button. 

After you have all the setting right, publishing your site is the easy part. It just 

takes a couple of mouse-clicks. In the Publish view, click the Publish button next to the 

Setup button. Doing so displays the Publish Site dialog box like the one in Figure 5.6. 

Figure 5.6. Publishing Your Site Takes Just a Couple of Clicks. 

Click the arrow to the right of the Location field to display a list of locations you 

have already set up. 
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Click the location you want. If you suddenly realize that you need to make a 

change to the specified location, you can do so by clicking the Edit button. If you have 

already published your site to the specified location, click the Publish Changed Assets 

Only check box if you want. Checking this box causes NetObjects Fusion to publish 

only the parts of your site that have changed, thereby cutting down on the upload time. 

However, I personally like to play it safe and upload the entire site every time. 

Click the OK button. If you forget to enter any important information during the 

setup process, NetObjects Fusion displays a warning, like the one in Figure 5.7, that 

tells you what is missing. 

Figure 5.7. Oops! You Need to Recheck Those Settings. 

Figure 5.8. Watch NetObjects Fusion Go! 

88 



VI. ADVERTISING YOUR WEB SITE 

Unfortunately, Web development is not a Hollywood movie. Perhaps the single 

most important thing you can do, aside from developing the site, is publicizing it. Web 

surfers do not find new sites easily by chances. It is your job to get the world out. 

6.1. Submit Your Web Site to Search Engines 

It should come as no surprise that the best place to publicize your new 

cyberventure is in cyberspace. Most Web surfers find their way around the Web by 

using one search engine or another. For the uninitiated, a search engine is a Web site 

that allows you to type in a word or words that relate to the sites you are looking for. 

One mouse-click, and the search engine displays a list of sites that may relate to your 

topic of interest. 

If this is how people typically find new Web sites, it stands to reason that you 

want your site listed on as many search engines as posible. The good news is that these 

search engines have strong motivation to include your site. The more sites they list, the 

more useful search engines are, and (hopefully) the more people will use them. Usage is 

important to these guys because they get most of their revenue from banner advertising 

- those sometimes annoying advertisements you often see on commercial sites. 

Because of their desire to draw in as many people as possible, virtually all search 

engines make it easy to add your site to their list - or at least initiate the process. This is 

where it becomes important to distinguish different types of search engines. 

You can break search engines down into two broad categories. Indexes - You 

have to register your Web page with this type of search engine before someone 

manually adds your Web page to the site's index. Yahoo! Is a good example of an 

indexed search engine. I cannot tell you exactly what criteria Yahoo! uses because it has 

not added some perfectly acceptable sites, while it is a snap to find sex-oriented sites 
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through Yahoo! Figure 6.1 shows the Yahoo! "add URL" page. Spiders - A spider-

driven site attempts to compile a listing of every single page on the World Wide Web. 

To do this, it employs automated software agents that actually go out on the Web 

looking for new sites to index. AltaVista (www.altravista.digital.com) is such a search 

engine. You may find that AltaVista eventually lists your site even if you do not take 

the time to manually add it. On the other hand, adding your site in this manner speeds 

up the whole process; the instant you are done, other people can find your site. Figure 

6.2 shows the Alta Vista "add URL"page. 
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Figure 6.1. There Is No Guarantee You Will Be Listed with Yahoo! 

90 



t ~d<1iryg Pages or !JRt.sto the 1nc1e:x 

l:::.fi::~:J:·-'~~ 
\ II lf!hE peg~ is su2ces~ff~ fetched;.~ Is ~ddedi~ ine ii!deicl!shOU!il 

} be .. ,.ilable fo( ~·t· •~pit<lll~ in less than a day ·:?ossibltlwo •... •.· •.. •·•• .• ······.=· .. =··_,: __ ,•_,• __ ,: __ =[ ..• • . ;.:: .·days for· our m1rfor·sd$,: · ·. · · ·. 

i IJ[Jo• not:siihmi! a d&•cripliiint>J keY.,ords wilh •:URL .Wcohtrol.the · · · .. 
• : · · ab£1racf •si<Jed. back With youipage; use Mfil£1~.iii . . . . · dlj 

=!t'~~f .·: ti Remembiir' ihi.i l:Fiur .;., case·•~nsa~. a;,,i pl~~~~ check your ··.•.•· .. •·.:.r_:·,:_:,•,i.• 

.• ..... • : . :;::• : ~pe111ng:. . · .. · .. ·.· 
.• \I.lo .•ls.o: accejl1,:~ubmissil)lis.ofUf1l.s thr<>ugh,ScOlt Ei•nf$1af'~ilubmit:• :•:•. ::::::; 
) W s•r•ice •no fia\ S'~~:i•ji'~ PcislMaSler $<lmces. · · · · · · · · · : : ::· ••:li\l 

.~:j:::~:~~:~~~~;~~~~ift~Wff:~~tRtm~.;::~t~de~~~·;: b~rr~:n~~~~ :~~d::S!P~S~s :. :::::::f;1;: 

. :•••Removin~·Pagts .• or,UR~•:~om the: hidtx. ·······11:1111 

iti¥1.;.ri:i~~~i~iEifaii&i~fa:1;faii:~ii:®li~i~i:i1~i~i~~~~~i~~~~~;:~;i~~i~~~::~::~~:;~~if i~;~iiii~~i~i~i1Iiim1j:=:E1wB~~~iwil 

Talihloir Contents 

~ifuri~~lf 

Figure 6.2. An Alta Vista Submission Is Active Instantly. 

Regardless of which type of search engine you visit, adding your site requires 

essentially the same steps. Somewhere on the home page for any given search engine, 

you are likely to find a button marked something like Add URL. Clicking this button 

takes you to an online form, where you type in the Web address you want to register, as 

well as other information about your site. The exact information you need to supply 

varies from search engine to search engine. After you complete the form, click the 

Submit button and you are on your way to having your site added to that search engine. 

Not sure which search engines to register with? This is the list of some of the most 

useful search engines: 
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Name URL 

Yahoo! www.yahoo.com 

Alta Vista www.altavista.digital.com 

Lycos www.lycos.com 

Excite www.excite.com 

WebCrawler www. webcraw !er.com 

Info seek www.infoseek.com 

HotBot www.hotbot.com 

Magellan www.mckinley.com 

Meta Crawler www.metacraw!er.com 

Keep in mind that hundreds of search engines exists on the Web, many of them 

dedicated to very specific topics. Perhaps a search engine exits that focuses specifically 

on your field of endeavor. If so, you can probably find it by using one of the general 

search engines listed in the above list. 

6.2. Linking with Other Web Sites 

The point here is that if your site has some relationship with the subject matter on 

another site, contact the owner of that site to see if you can trade links. These simple 

link exchanges benefit both parties involved and, best of all, do not cost either party. If 

you are not sure about the existence of sites related to your site, visit your favorite 

search engine and search for it. 

6.3. Printed Material 

Exciting as the World Wide Web may seem, the truth is that most people still get 

most of their information from printed material. Depending on the nature of your 

enterprise, you may generate a lot of printed material. You may issue press releases, run 
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advertisements in various newspapers and magazines, write letters, and hand out your 

business card at professional get-togethers. 

Each time your company's name appears in print - no matter where it is - that is 

an opportunity to spread the word about your Web site. Here is a quick checklist to help 

make sure you are taking advantage of every printed opportunity to promote your cyber 

presence. 

Change all company letterhead to include the company Web site's URL. This 

information is equivalent to phone and fax numbers, and you should present it in the 

same manner. 

Reprint everyone's business cards to include the company's URL. Issue a press 

release to announce the launch of your Web site. Modify any print advertising to 

include your URL. IF your company produces a packaged product, make sure to include 

your Web address on the packaging. Include your URL in the signature line on all your 

e-mail. 

6.4. Banner Link 

If you do not have big bucks to spend on ad banners, consider using a banner 

exchange network. It works like this: you join a banner exchange service such as 

LinkExchange or SmartClicks. The service guarantees that your ad banner(s) will 

receive a certain number of exposures on other member sites. In exchange, you promise 

to display other members' banners on your site a certain number of times. Typically, 

you receive one exposure for every two you give; the exchange companies make their 

money by selling the difference to paying advertisers. Most services also provide 

statistics on access and click-through rates for your ads. 
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To target a more specific audience, try a more specific exchange service, such as 

the Mac Web Network or Gamers Link Xchange. Check out Mark Welch's list of 

general and specific banner exchanges to find one or more that work for you. 

Figure 6.3. Use a Banner Exchange Service. 

6.5. Find the Right Newsgroup 

With more than 15,000 newsgroups m the Usenet system, fmding the most 

pertinent place to post a message can be a challenge. Reference.com and Deja News--

two search engines devoted to cataloging newsgroup information--make searching 

through the hierarchies of newsgroup categories relatively painless. 

Different newsgroups have different standards for what posts are considered 

appropriate. Some welcome polite promotion of relevant sites. (The 
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comp.infosystems.www.announce newsgroup, for instance, is devoted to introducing 

new, noncommercial Web sites.) Do not post to a newsgroup without reading a 

selection of previously posted messages. Look for a FAQ list to find out what is kosher 

for the group and what's not. 

Resist the temptation to post to multiple newsgroups. Nothing makes Usenet 

enemies faster than posting indiscriminately and to inappropriate forums (known as 

spamming). If you are certain more than one group needs to know about your site, save 

bandwidth by specifying all the pertinent newsgroups in the To field of a single 

message; "smart" newsreader applications will not download the file more than once. 

Figure 6.4. A Good Place to Visit to Improve Your Web Site Promotion. 
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VII. TAKING AN ORDER ONLINE, 
OPEN YOUR SHOP WITH CCNOW.COM 

To sell your product online, you have to be able to charge your customer's credit 

card. As I am writing this report, the policy of E-commerce in Thailand is not finished 

yet and there is no standard for the way of credit card to be charged. Most banks will 

accept the charge with the customer signature, without signature the customer will be 

able to cancel that charge. Although some ISPs in Thailand have set up their way of 

payment on the Internet, I think it is not going to work because, for me I do not want to 

register or deposit my money for each system of each ISPs. Therefore I will use 

CCNOW as my online retailer. With CCNow I can sell my products online without 

spending any money for setup cost. Figure 7-1 shows the homepage of cconow.com. 

1:1wm~i1:··.. . . . .. .. ::i:::m:i~i:~:j~ir i~~~~ri~r=· ......... ~i:i~illi'llJ·iwi:i:m~:@R'...... Tl~:lil1::1~i 
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Figure 7.1. CCNow Web Site. 
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7.1. An Overview of CCNow 

CCNow is a provider of electronic commerce solutions for small businesses. Its 

integrated E-commerce package, which includes centrally managed shopping-cart 

software and credit card transaction processing services, is designed to help you sell 

merchandise directly from your Internet Web site. CCNow's user-friendly interface will 

get you started quickly, and with a minimal investment of time and money. 

Many small business owners would like to accept credit cards for payment online, 

but have been unable to realize that goal. Some lack the resources to set up Internet 

merchant accounts with the major card companies, while others have concluded that 

setting up shopping-cart software is not worth the hassle and expense. If you are trying 

to find a way around these problems, CCNow may be the answer. 

As CCNow client, you designate CCNow as an online retailer of your products. 

Then your Web Designer will link your web site to the shopping cart screens on our 

secure server. This allows customers to purchase items on your web site using any 

major credit card. You do not need to spend the time and money to set up your own 

retail business, merchant accounts, and customer-service staff. In fact, you do not even 

need to install any software or hardware. As your online retailer, CCNow handles all of 

the technical work for you. 

Customers will appreciate CCNow too. They will never pay sales tax on any U.S. 

orders because our company is based in Delaware. And if there is ever a billing inquiry 

or card payment question, they can call our toll-free customer service number. 

Shop around, and you'll find that CCNow offers you a very competitive fee 

structure. CCnow collect just 8% of each sale, and there are absolutely no startup costs 

and no_monthly fees. Please read Appendix D for more information of CCNow. 
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7.2. Register with CCNow and Begin Selling Your Product Online 

Before you sign up with CCNow I suggest you take sometimes to read all 

information from its Web site at http://www.ccnow.com/overview.html for overview of 

CCNow and at htt;p://www.ccnow.com/details.html for more detail and FAQ of 

CCNow. If you have more questions, you can contact the sale person directly by e-mail 

at sales@ccnow.com. After you have read all detail and decided to signup with their 

service. In the Appendix E will show you the form that you have to fill in. 

CCNow provides you with customized snippets of HTML code to insert into your 

Web pages. This lets you easily refer customers to its secure shopping facility. 

Customers can select products for purchase and add them to a virtual "Shopping Cart" 

provided by CCNow. When finished shopping, the customer presses the Checkout 

button and enters his/her credit-card and shipping information to complete the sale. At 

this stage, CCNow is acting as your online retailer, selling products to the customer and 

simultaneously buying the products from you at wholesale. In return for the 8% 

wholesale discount you give to CCNow, CCNow administers the shopping-cart 

software, the credit card transaction processing, and our customer service functions. All 

orders are then billed to customers by the company as "CCNow". After each batch of 

orders is submitted and processed, CCNow will send you notification of the orders via 

Internet E-mail. You then ship the products directly to the customers, and use CCNow 

Client Administration screens to notify us of the shipment. You can see samples of 

CCNow Client Administration screens in Figure 7 .2. 
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Figure 7.2. This Is a Sample of My CCNow Client Administration Screen. 

From the CCNow Client Administration Web page you can add or modify your 

product list, see your monthly sales report, modify your information and setting, like 

your address, name or shipping charge. 

7.3. What Types of Products Can Be Sold? 

You can use CCNow to sell a wide variety of merchandise. Please keep in mind 

the following guidelines and restrictions, however. CCNow is intended to be used for 

tangible merchandise. This is defined as "physical products that are shipped to the 

customer's physical address". This policy helps CCNow to maintain 8% fee. Tangible 

merchandise incurs a much lower rate of inquiries, disputes, and fraud than service-
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based sales or electronically delivered products. CCNow has elected to provide services 

only for tangible merchandise, so that the clients can enjoy a lower processing fee. 

Due to product liability concerns, CCNow cannot sell firearms, alcoholic 

beverages, explosives, live animals, prescription drugs or other controlled substances, 

fireworks or other pyrotechnic devices or supplies, or hazardous materials such as 

combustibles or corrosives. 

Your products must be legal for sale in all states, provinces, and countries where 

you accept customers. The minimum price for each product you sell is $4.95. 

7.4. What Are the Benefits of Using CCNow? 

Here are a few of the benefits to consider. You save money. Most online retail 

operations incur significant start-up costs which can impede the profitability of a new 

business. With CCNow as your retailer, you avoid these expenses and pay just 8% of 

each sale. 

Your customers save money. Our company is based in Delaware, which means 

that customers are never required to pay sales tax on any U.S. orders. 

Your customers can call us directly if they have billing inquiries or other 

questions. You can use CCNow with any web hosting service because there are no 

special set-ups required. This can save you money by allowing you to choose a 

standard, no-frills hosting company for your Web site. 

You can turn on "international orders" option if desired, and CCNow will take 

orders from customers anywhere in the world, at no additional charge. Most retailers 

will not accept orders from overseas customers. 

CCNow provides you with an easy interface to the shopping-cart screens on our 

secure server. You do not have to do any programming, and CCN ow will even provide 
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you with customized snippets of HTML code to drop into your Web pages. CCNow is 

free to join, and you can literally start taking orders today! 

7.5. What Are the Limitations of Using CCNow? 

Here are a few of the limitations to consider. You cannot charge your clients with 

another currency. CCNow will accept only US Dollar. 

You cannot give discount for your clients in total sales amount, but if you want to 

give discount to your clients, you have to reduce the price of each product manually at 

Client Administration page. You cannot charge your shipping cost for various 

destinations, CCNow will provide you with only 3 destinations which are - 1. US and 

Canada - 2. Europe - 3. International or other countries. 

7.6. How Are Payments Made to CCNow Clients? 

CCNow makes payments to the clients twice a month, on the 1st and 16th day of 

each month. The payment schedule is - Orders shipped from the 1st thru the 15th day of 

the month are paid on the 16th of that month. 

Orders shipped from the 16 thru the last day of the month are paid on the 1st of 

the following month. 

Payments are issued to the name and address that you specified when you created 

your account. If you need to change the payment name, address, or method, please use 

the "Contact CCNow" function to write a note with the new payment instructions. 

All CCNow payments are adjusted for any refunds, disputes, chargebacks, or other fees 

as set forth in the Client Agreement. You can choose from three different methods of 

payment: 

Option 1: CCNow can mail you a regular check. This is the default payment 

method. CCNow sends these checks via First Class Mail within the U.S, or by Air Mail 

to all other countries. No charge. 
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Option 2: You can choose to be paid by Cashier's Certified Cheque. This is useful 

to some clients outside the U.S, because some banks may require several weeks' waiting 

time for a non-certified foreign cheque. CCNow sends these cheques via Air Mail. 

$15.00 bank fee per cheque. Your bank may collect additional fees. 

Option 3: CCNow can send payments directly to your bank account via Wire 

Transfer, also called Tele-Transfer in some countries. You may wish to consider this 

option if you have problems with the reliability or speed of mail delivery in your area. 

$50.00 bank fee per payment. Your bank may also collect additional fees. However, 

banks in Thailand do not charge for incoming fund transfer. 

Other notes regarding payments: 

If you wish to receive payments less often than twice per month (for example, in 

order to reduce your bank fees), you can specify a Payment Threshold amount. CCNow 

will only generate payment if the payable amount exceeds your chosen Payment 

Threshold on the 1st or 16th day of each month. 

If you are in the U.S, you will soon be able to choose direct deposit of funds into 

your bank account. This is a free service, and CCNow expect to begin offering Direct 

Deposit during 1999. 

All CCNow payments are adjusted for any refunds, disputes, chargebacks, or 

other fees as set forth in the Client Agreement. 

For more detail please see Appendix D or you may contact the CCNow sales 

person directly with e-mail that I have provided earlier - service@ccnow.com. 
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APPENDIX A 

REGISTER WITH THAINIC 
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This page provides general information about our operations and agendas. This 

document is written in the way that users can easily browse the topics that are related to 

their interests. THNIC reserves the right to revise, add, and treat new policies 

retroactively. Below is the list of key terminology and explanation. 

Types of registered domains: Anyone can apply for a third level domain name 

under .th umbrella at THNIC for active use. Holder of domain name: Each domain 

name must have a holder, who can be either declared as "organizational contact" or 

"administrative contact" if in case of natural persons. 

Prior to submitting an application: Prospective domain name holders are 

responsible for ensuring that at least two name servers are configured and operable prior 

to submitting their application, otherwise registration process cannot proceed. 

Fees and invoices: Each domain name is subject to registration and annual 

maintenance fees. THNIC will bill the contact persons as listed in the application forms. 

Processing order of requests: THNIC treats every incoming request on a "first-come, 

first-served" basis. The entity seeking registration is fully responsible for their entries 

and is therefore required to supervise any records in the repository related to their 

entities. Applications for name modification or deletion are also based on the same 

procedure as new applications, except for some circumstances or special requests posed 

by the registrants. 

Registration procedures: It normally takes THNIC 3 working days to complete the 

registration procedures for each valid application. 

Termination of registration: THNIC can delete a domain name under .th hierarchy 

when: 

(1) It is the request of the domain name holder. A holder who wants to have a 

domain name deleted can send in a request using THNIC's form. 
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(2) The holder fails to fully pay the registration and annual maintenance fees 30 

days after the due date. 

(3) Any registration can be invalidated unpon court order. 

Deleted domain name will immediately become available for any party. 

Responsibilities of domain: An entity registering for a domain name is fully 

responsible for their rights to its name. Submission of a domain name registration 

guarantees THNIC that the entity has all rights to use to submitted name. Therefore, it is 

necessary that the applicant make sure that he/she supply THNIC with the correct 

information in the application form and will bear all the rights to use the name as stated 

in the application. The name holder will identify THNIC from any litigation costs or 

damages resulting from entity's use of its domain name. THNIC is hereby clearly 

exempted from any and all responsibility to verify the rights of the name. 

Transfer of domain names: Domain names should be used by the designated 

holders, or the persons stated in the application, only. THNIC does not trades in, or 

licenses any entity to trade in, domain names and is not be responsible for any transfer 

of domain name. 

Solving conflicts: THNIC will not be an arbiter of conflicts that may occur 

between holders of domain names. It is the responsibility of each applicant to research 

in our name registry before choosing a domain name. Also, THNIC is not responsible 

for the name chosen by each applicant if later found unsuitable by other entities. 

However, if a conflict occurs during the registration procedure, THNIC will hold the 

process until the case has been settled in a written legal agreement signed by both 

parties and a court of legal and submitted to THNIC 

THNIC's liability: THNIC will neither be liable nor responsible for any loss of 

use, interruption of business, or any indirect, special, incidental, or consequential 
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damages of any kind (including loss of profit) regardless of the form of action whether 

in contract, tort (including negligence), or otherwise, even if the registry THNIC has 

been advised of the possibility of such damages. 

Domain naming: Each domain name must contain at least 2 characters, but no 

longer than 24 alpha-numeric characters (a-z, 0-9). It can also contain special 

characters, such as a hyphen (-), but not at the beginning or the end of the name. Also, 

the chosen name should be strongly similar to applying entity's full name or 

abbreviation. 

Number of domain name: Each entity can apply for only one domain name for 

ALL above domain names. 

False information: THNIC is intolerant of any false information provided at the 

application. If we become aware of any false information, we reserve the right to hold 

or cancel that domain name without having to notify and refund the name holder. 

WHOIS entry: THNIC files all registered domain names in its repository. The 

information can be queried by "whois" (who is) command on any shell account or from 

THNIC's "whois" web page. For example, if you want to know who is "thnic.net," you 

just type "whois -h whois thnic.net" at the prompt of your shell account. This will 

provide you with the domain name holder's full name, its administrative, technical, and 

billing contacts, as well as pointers to hosts providing name service for the domain. 

Privacy: THNIC reserves the right to make entries in the WHOIS database publicly 

available in any written or online forms. 

Spam protection: Spamming is unacceptable. THNIC reserves the right to revoke 

the registration of the domain name once it learns that the name is used for any unlawful 

purpose, including electronic theft and sending unsolicited bulk emails. 
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APPENDIXB 

DETAIL OF CCNOW 
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CCNow is an online retailer of our clients' products. Our focus is on selling 

tangible merchandise that will be shipped to customers. Clients who use CCNow sell to 

us at wholesale; we then sell to customers at retail. All orders are then billed to 

customers' credit cards under the generic name "CCNow". We pay our clients twice per 

month, on the 1st and 16th day of each month. Complete payment options and 

information are listed below. Headquartered in Newark, Delaware, CCNow is a small 

business (1998 sales: $4 million) specializing in Internet retail services and systems 

design. Our parent company, CCI Marketing Group, was founded in 1996 and is 

privately held. 

CCNow provides you with customized snippets of HTML code to insert into your 

Web pages. This seamlessly links your Web site into the shopping cart screens on our 

secure server. Customers navigate their way through your Web site, selecting products 

for purchase and adding them to a virtual "Shopping Cart" provided by CCNow. When 

finished shopping, the customer presses the Checkout button and enters his/her credit

card and shipping information to complete the sale. At this stage, CCNow is acting as 

your online retailer, selling products to the customer and simultaneously buying the 

products from you at wholesale. In return for the 8% wholesale discount you give us, 

CCNow provides you with shopping-cart software, credit card transaction processing, 

and our toll-free number for card billing inquiries. All orders are then billed to 

customers' credit cards using the generic name "CCNow". After each batch of orders is 

submitted and processed, we will send you notification of the orders via Internet E-mail. 

You then ship the products directly to the customers, and use our Client Administration 

screens to notify us of the shipment. You can see samples of CCNow Client 

Administration screens by clicking on the tool bar below. 
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For our services, CCNow collects 8% of the total amount charged to each 

customer's credit card. There are no startup costs, monthly fees, or other charges for this 

service. 

Example: Suppose you advertise a product for $8.00 and charge an additional 

$4.00 for packaging and shipping. Customers would pay a total of $12.00 for that order. 

CCNow's fee is 8% of this total (96 cents), and the rest ($11.04) is paid to you. 

CCNow works with clients throughout the world, and we are glad to offer our 

services to non-US businesses. Currently our software requires that all product prices be 

displayed in U.S. dollars, and all payments are made in U.S. dollars as outlined in the 

product guidelines above. Typically, CCNow pays our clients by mailing cheques twice 

a month, on the 1st and 16th of each month. Most major banks are able to accept a 

deposit of a U.S. cheque and convert to the local currency. 

We have several other payment options available, some of which are particularly 

useful to our international clients. For example, you can choose a wire transfer payment 

or certified cheque in order to speed the clearance of your payments. You can also 

choose a Payment Threshold amount in order to reduce your bank fees. 

Payments are issued to the name and address that you specified when you created 

your account. If you need to change the payment name, address, or method, please use 

the "Contact CCNow" function to write a note with the new payment instructions. 

All CCNow payments are adjusted for any refunds, disputes, chargebacks, or 

other fees as set forth in the Client Agreement. You can choose from three different 

methods of payment: 

Option 1: We can mail you a regular check. This is the default payment method. 

We send these checks via First Class Mail within the U.S, or by Air Mail to all other 

countries. No charge. 
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Option 2: You can choose to be paid by Cashier's Certified Cheque. This is useful 

to some clients outside the U.S, because some banks may require several weeks' waiting 

time for a non-certified foreign cheque. We send these cheques via Air Mail. $15.00 

bank fee per cheque. Your bank may collect additional fees. 

Option 3: We can send payments directly to your bank account via Wire Transfer, 

also called Tele-Transfer in some countries. You may wish to consider this option if you 

have problems with the reliability or speed of mail delivery in your area. $50.00 bank 

fee per payment. Your bank may also collect additional fees. 

There will be some more detail on CCN ow web site, if you want to see more 

please go to www.ccnow.com. 
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